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Introduction

This book is a road trip. In it, you'll find information on the
PowerPC chip, RISC technology, and a C development environ-
ment by Metrowerks called Metrowerks CodeWarrior. You'll find an
assortment of programming hints and tips and insights into how
the Mac works, and you'll discover what new features—and
pitfalls—await on the PowerPC chip. Most important, while I'll
supply plenty of programming examples, I'll also explain how the
Power Mac works. I firmly believe that if you understand how
something works, you're in a better position to use it (or in the case
of a personal computer, program it).
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What You’ll Need

My basic assumption is that you know how to use a Macintosh and have
some knowledge of the C programming language. If you're not familiar with
C, the best reference on this language is Kernighan and Ritchie’s The C
Programming Language, Second Edition, published by Prentice Hall. You
also should have Apple’s reference works on the Mac Toolbox, Inside
Macintosh. 1 also assume you're familiar with using the CodeWarrior devel-
opment tools. You’'ll have a demonstration version of Metrowerks
CodeWarrior called CodeWarrior Lite on the CD-ROM accompanying this
book. Check out its documentation files if CodeWarrior is new to you. If you
don’t have a Power Mac (yet), that’s OK. Much of the material in here works
with existing Macs as well, which is perhaps the real beauty of the PowerPC
design.

I have structured this book so that it offers material useful to both novices
and experienced Mac programmers. The novice should start at the begin-
ning, but more experienced programmers should feel free to browse about
and find a subject of interest. Consult the brief summaries at the beginning
of each chapter to determine if the material is of interest to you. The follow-
ing brief road map will help you decide your course.

The Road Map

Chapter 1 covers the Power Macs themselves, including the latest systems
such as the Power Mac 9500, 8500, and 7500 that incorporate the industry-
standard PCI bus. It also provides a brief peek at the PowerPC family of
processors—the PowerPC 601, 603, 603e, 604, and 604e—that gives these
systems their great horsepower. It also discusses how these computers
manage to run existing Mac software, thereby preserving that pile of Mac
software you've accumulated over the years.

Chapter 2 helps you write your first real C program. It won’t have a friendly
Mac interface, but it will perform a useful job. If you're new to the Mac,
bypassing the user interface details for the moment limits the number of
unknowns you have to deal with while you gain confidence with the develop-
ment tools.
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In Chapter 3, you'll tackle some of those user interface details dodged in
Chapter 2. You'll add a friendly interface and discover the forked nature of
Mac files. If you don’t know what a Mac file’s data fork and resource fork are,
don’t worry. This chapter will explain them to you. You'll also learn about
resources (which, not surprisingly, reside in resource forks) and how to edit
them for use in your program.

Chapter 4 is a rest stop on our journey. You will have reached a point where
you must lay aside your tools for the moment and gain some insights into the
Power Mac’s new system architecture. I'll explain how Apple managed the
feat where one set of source code can support two different processors. I'll go
on to describe how the underpinnings of the Power Mac, as much as it
resembles the 680x0 Mac on the surface, are fundamentally a different
operating system. I'll explain what code fragments are, and what they mean
to future application design. In addition, I'll describe Apple’s Mixed Mode
Manager, the part of the operating system that manages to keep two wildly
different sets of processor code—the 680x0 and the PPC—operating in
harmony. It will be of general interest to most readers, and required reading
for those writing special programs and extensions. Finally, I'll explain how
both 680x0 and PowerPC code can be embedded in a single application file—
that fat binary mentioned earlier—so that such an application is capable of
running on either Mac. You’'ll use some of these details later when you
explore certain Power Mac-specific features.

Chapter 5 is where you put into practice the information you learned in
Chapter 4. Most of this material will be of interest to advanced programmers.
You'll write an application that controls the Mac’s File Sharing software. This
will require writing a function that works with the Mixed Mode Manager to
enable a switch between 68K and PowerPC code. I'll also show how to make
this application a fat binary, capable of running on both 680x0 and Power
Macs. Next, you'll write an Extension that changes a Power Mac'’s screen
depth. You’'ll see how to access code fragments. It also demonstrates how to
patch the operating system, both for a 680x0 Mac and Power Mac.

In Chapter 6, it’s time to focus on how to fix a program that misbehaves.
Information on the types of debuggers, and debugging tools can be found
here. A look at CodeWarrior’s high-level debugger is provided. Tips on
debugging and defensive coding are discussed.
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Chapter 7 delves into processor-specific details and how they affect your
application’s operation. These details will help you decide strategies to get
the best performance out of your code.

For those who want a better understanding of the processors, Appendix A
provides a look at the PowerPC family.

Appendix B consolidates information on how to port an existing Mac
application’s C code to the Power Mac. It will be of interest to advanced
programmers who just want to dive in and start retooling their programs
immediately.

Appendix C provides the complete source listings for the programs discussed
in this book.

Appendix D tells you how you can locate more CodeWarrior and Power Mac
programming information.

The Metrowerks CodeWarrior Lite
on the CD

The PowerPC Programmer’s Toolkit CD contains the CodeWarrior Lite
version 1.3 integrated development environment (IDE). CodeWarrior Lite
prevents you from creating new source code files or projects. It also prevents
you from adding new files to an existing project. Other than these restric-
tions, CodeWarrior Lite has the same capabilities as a full-fledged version of
Metrowerks CodeWarrior 1.3 (aka CW8).

The text of this book was written using the full version of Metrowerks
CodeWarrior. You’ll have to use slightly different steps when using
CodeWarrior Lite from the CD. The commands New, New Projects, and Add
File... are not available. Because of these limitations, it can work only with
the sample files provided on the CD.

So, if you are following along using CodeWarrior Lite, when the text tells you
to use the New, New Project..., or the Add File... command, you should
instead open the related project file and keep it open throughout the exer-
cise. All the associated files will already be in the project, so you won’t need
the Add File... command. Then, you can follow the same procedures as if you
were using the full version of CodeWarrior.
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Note: We've provided all the code discussed in the book on the CD, so you
don’t have to retype it, unless you find it valuable to do so.

You also should note that Metrowerks cannot provide technical support for
the Lite version. You can, however, get all the CodeWarrior information you
could ever want and also meet other CodeWarriors. After you buy a full-up
version, Metrowerks will be happy to provide full technical support.

Additional Notes

There probably are better ways to write some of the functions presented here
and I welcome input from you. The purpose of my code, however, is to
illustrate Power Mac features while being readable by an audience of C
programmers with a wide range of experience. I also bias my code toward
readability because, more often than not, six months later I usually have to
modify the code for use in other projects.

While I've tried to produce error-free code, and I actually use some of these
programs in my day-to-day work, it’s possible that some of the code samples
have bugs. Please send me bug reports via email or some other means. If you
have access to AppleLink, my email address is T THOMPSON, while on the
Internet it is tom_thompsonebix.com. If you prefer a more conventional method,
mail your comments and bug reports to me in care of Hayden Books.

Please note these signposts along the road as we travel.

Background Info

Magnifying Glass icons flag sections of the book where additional back-
ground information can be found. For those unfamiliar with a topic, this
extra information promotes a better understanding of the material. Sea-
soned Mac programmers can skip these sections.
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important

Lightning Bolt icons signal important topics. These sections provide infor-
' mation necessary to understand the material in each chapter, or illustrate
an essential point of the software or operating system. Even seasoned
programmers might want to examine these sections for Power Mac-specific
details.

Hazard

Bomb icons signal potential hazards. These sections supply crucial informa-
tion required to keep your program from crashing and your Power Mac
system intact. Do not skip these parts of the book.

@ Future Directions

Eight Ball icons indicate information that is applicable to the direction that
' Apple is taking the Macintosh platform, and operating system. You might,
for example, find information on the Common Hardware Reference Platform
(CHRP) here, or on Apple's next release of its operating system, code-
named Copland.

User input text appears in a bold monospace font, as in:

Type MyFile and press Return.

Directives, routines, streams, and functions appear in a monospace font,
asin:

Before we call Munge_File(), we fetch the stopwatch cursor icon using GetCursor().

Filenames appear in quotation marks, as in:

For a complete source code listing, check the file “switchBank.c” on the
CD-ROM.

The symbol = has been used to represent program lines that have wrapped.

Well, enough preliminaries. Let’s hit the road....



The Power
Macs and a
Brief History

History of the Power Macs

In early 1994, Apple changed the face of the personal
computer industry—again. The company took a
powerful processor technology previously available
only in expensive workstations and offered it to small
businesses and average users through affordable
desktop computers. These low-cost computers,
however, won't run those arcane workstation operat-
ing systems. Instead, they offer an interface renowned
for its ease of use: the Macintosh operating system, or
Mac OS. Put simply, Apple has introduced a new line
of high-performance Macintosh computers, the Power
Macs.

Because these Power Macs borrow heavily from the
Macintosh design, a brief history of the Mac is in
order.
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The Early Mac

Just a decade ago, Apple introduced its newest personal computer during the
1984 Super Bowl. This famous commercial, titled “1984” and directed by
Ridley Scott, depicted a bleak, gray, future dystopia where shaven-headed
drones shuffled toward the ultimate video conference. A runner—hammer
held high and wearing an Apple logo on her shirt—raced onto the scene,
hotly pursued by the faceless thought police. The hammer was hurled at the
conference screen, shattering it. The implication was that Apple’s then-new
Macintosh computer would save us from that same gloomy fate. The verdict
is still out on whether the Mac accomplished that goal, but no one disputes
its effect on how we deal with computers and information. Desktop publish-
ing, digital image editing, color printing, and other applications were either
invented on the Mac or driven by the demands of its users.

The original Macintosh (now termed “classic Mac” in Apple’s technical
literature) was a small beige box with a 7.83 MHz 68000 processor. It came
equipped with a built-in 9-inch black-and-white monitor, 128 K of random-
access memory (RAM), a single custom 3 !/2-inch Sony floppy drive, two
serial ports, and 64 K of read-only memory (ROM). The classic Mac was a
“closed system” because it offered no slots or easy expansion capabilities.

The Mac ROMs provided a large array of support routines that implemented
the graphic user interface (GUI) and system services such as memory man-
agement and file I/O. These routines are known collectively as the Mac
Toolbox. Because it’s easier to use the Toolbox services than write code from
scratch, the Mac always has encouraged a consistency in application design.
Much of the Mac’s “personality,” or behavior, comes from these Toolbox
routines.

/ Important

‘ Because Toolbox routines are relied on heavily when writing a Mac
application, expect to become familiar with them as you progress through
this book. Keep /nside Macintosh nearby; those manuals provide important
details on Toolbox routines. As you become comfortable with programming
the Mac, you'll frequently consult them when writing new applications and
adding features to existing applications.




Chapter 1 m The Power Macs and a Brief History

- e - e ww e e e e n ke G e wm e m e G Em Ee e M Em me e MR SR e R e e e e e e R e e e M m e e e e me

Because well-behaved applications only access the system through the
Toolbox interface, Apple has retained the option of significantly revising the
hardware and software behind the interface without requiring modifications
to existing applications. A new Mac, for example, might use a new stereo
sound chip, but your application would still use the same sound generation
routines and be able to play music or sound effects on it. That’s because
while the Toolbox sound routines still present the same interface to the
programmer, the code underneath this interface layer converts your
program’s commands into a format the new hardware understands. This
design eliminated many compatibility problems as Apple enhanced both the
Toolbox routines and the hardware. Of course, not all compatibility prob-
lems were avoided, but Apple was able to limit them by using the Toolbox to
define a “virtual machine.”

Just as important, the Mac GUI helped enforce a consistency in the appli-
cation’s user interface, making Mac applications easier to use than those on
other computers. After you mastered one application, you knew the basics of
using other Mac applications as well. To be sure, there were application-
specific features users had to learn (text formatting in a word processor, or
how to use a pen tool in a drawing package), but they didn’t start over each
time with the basics. They could always count on finding file manipulation
commands under an application’s File menu, and locating the editing
commands in the Edit menu.

Faster and Better

Over the years, Apple improved the original Mac and introduced new mod-
els. First the company added more memory and a SCSI port. With the Mac I,
Apple used the faster 68020 processor and opened the computer’s closed
design by adding NuBus slots. It introduced newer Macs with faster proces-
sors and a larger array of features. These machines went by such arcane
names as the Mac Ilcx, Ilci, IIsi, IIvi, and IIvx. Apple minimized the confusion
temporarily by giving certain product lines unique group names. The Mac
notebook computers were labeled PowerBooks. Numbers were tacked onto
the end of the names to help identify the characteristics of each computer.
Still, things got out of hand. A mid-range line of Macs, labeled Centris,



appeared and disappeared, being integrated into the Quadra product line.
Apple introduced a Performa line of Macs, which were identical computers
but repackaged for the home market. Mac system taxonomy and nomencla-
ture began to require a scorecard—a very large one at that.

The First-Generation Power Macs

This brings us nearly to the present. Apple was feeling competitive market
pressures to lower costs and improve performance. To reduce hardware
design costs, Apple standardized most of its computers on the following
three basic models.

B The first model uses a low, compact chassis with minimalist expansion
capabilities to reduce costs. This design debuted with the Centris 610,
followed later by the Quadra 610. It has a single Processor Direct Slot
(PDS) that’s connected directly to the processor bus. By use of an
adapter, the PDS can accept one NuBus board.

B The second model is a desktop configuration that offers three NuBus
expansion slots and more capacity for internal peripherals. This chassis
was first introduced with the Mac Ilvx and was subsequently used in the
Centris 650 and Quadra 650 systems.

B The third model is a mini-tower chassis introduced with the Quadra
800 and followed by the Quadra 840AV. Like the second model, this
tower system offers three NuBus slots. However, there’s ample space
for three to four large SCSI hard drives internally, plus a beefy power
supply to support them.

All three models have a bay for adding an optional CD-ROM, other remov-
able media drive, or a high-capacity hard drive.

In the area of performance, Apple had been investigating the use of RISC
processors in future system designs. This research was evident in products
such as Apple’s 8x24 GC display board, which uses an AMD 29000 RISC
processor to accelerate screen drawing. In addition, the company demon-
strated System 7, which was written for the 680x0 processor, running in a
software emulator on a Motorola 88000 RISC processor.
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Background Info

RISC is the acronym for Reduced Instruction Set Computing. This proces-
sor design achieves its high processing speed by implementing many
simple instructions. These instructions usually are of a fixed length and
execute very rapidly, usually one instruction for every tick of the system
clock. This speed is accomplished by limiting what each instruction can do.
A handful of instructions, for example, load data from memory to a register,
or store data from a register to memory. All other instructions perform fast
operations on the contents of the processor's many registers.

These instructions are carefully tailored to minimize overlap between the
operations of other instructions. This lets processor designers add execu-
tion units—subsections of the processor dedicated to a specific function,
such as an integer math unit and a floating-point math unit—that can run
in parallel and boost performance by executing two or more instructions
simultaneously. As you might expect, simpler instructions require you to use
more of them to implement a specific task, so RISC programs typically are
larger than Complex Instruction Set Computing (CISC) programs.

We can contrast RISC processors with CISC processors like the Motorola
680x0 and the Intel x86 family. CISC uses variable length instructions to
achieve high code density (that is, lots of instructions can be packed into a
small amount of memory). These instructions, as their name implies, can
perform a sophisticated set of operations and use a wide variety of ad-
dressing schemes. One instruction might perform an operation on a
location in memory, then step to the next memory location. Another might
retrieve a value from memory and then perform a math operation on it.

While some of the simpler CISC instructions can be completed in one clock
tick, many cannot. There are several reasons for this. First, because of the
variable-sized instructions, the processor is forced to decode the incoming
bytes to determine an instruction’s length. This takes a clock cycle to
perform the initial decode, and then the processor spends additional clock
cycles reading in the rest of the instruction. Second, a complex instruction
that modifies a memory location requires extra clock cycles to perform the
bus operations necessary for the memory access.

continues
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continued

Finally, the very complexity of CISC instructions often requires the imple-
mentation of a small internal processor—a processor within a processor, so
to speak—dedicated to instruction decoding and processor control. This
internal processor uses programs called microcode that perform the
decode operations. Again, this additional layer of complexity requires extra
clock cycles to shuffle instructions through the decoder and operate the
microcode that translates the instruction bits into processor actions.
Because of RISC's simple instructions, a sophisticated decoder isn't re-
quired: You won't find microcode inside a RISC processor. The RISC
instruction decoder is implemented completely in hardware and runs at
hardware speeds. It takes only several clock cycles at most to translate a
RISC instruction into its corresponding actions. A RISC processor’s perfor-
mance is better than a CISC processor's because it can execute more
instructions for a given set of clock cycles than the CISC processor.

If RISC technology is so much better than CISC, why is the latter so
pervasive on desktop computers? RISC came onto the computing scene
much later than CISC. RISC came out of research at IBM, Stanford, and
Berkeley in the early 1980s and wasn't commercialized until the middle of
that decade. In contrast, Apple Computer sold its first microcomputer, the
Apple |, in 1976. By the time RISC processor architecture appeared in the
computing industry, CISC processor architecture had been in use for
practically a decade.

While CISC has a big advantage in terms of an existing software base,
RISC's performance edge should entice users to make the switch. RISC not
only allows personal computers to run tasks such as spreadsheets, image
editing, engineering simulations, and 3-D image rendering significantly faster,
it also provides sufficient horsepower to enable a host of new system
services and applications. Some of the possible new system services include
a robust, multitasking operating system with memory protection and pre-
emptive scheduling, multimedia services such as MPEG decoding and
display, integrated telephony and fax functions, voice and handwriting
recognition, and speech synthesis. New applications would be real-time data
processing, effortless 3-D image generation and manipulation, and all sorts
of multimedia work. For more information on the architectural advantages of
RISC, check out Appendix A.
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Apple and IBM: Who Could Have
Imagined It?

In 1991, Apple teamed up with Motorola and IBM to form an alliance

to define the next-generation processor for future desktop computers.
Despite the huge legacy of applications composed of CISC code on their
respective platforms (Intel x86 code on IBM PCs and Motorola 680x0 code
on Macintoshes), they decided that only RISC offered the necessary per-
formance. Cost was an important factor here too. What hindered the
acceptance of other RISC systems was the high cost of the RISC processor’s
fabrication, which in turn resulted in expensive computers.

The alliance is designing and producing a family of RISC processors to be
introduced in stages. Each family member is targeted at a specific segment of
the computer market. The first family member, the PowerPC 601, was intro-
duced in April 1993. It’s targeted at the low-end desktop market, but offers
better performance than today’s most advanced CISC processor, Intel’s
Pentium. In October 1993, the alliance introduced the PowerPC 603, a low-
power sibling to the PowerPC 601. It is geared toward the notebook market.
In April 1994, the PowerPC 604 was announced. Its high-performance design
with multiple execution units addresses the mid- to high-range desktop
market. The PowerPC 620, introduced in October 1994, is optimized for high-
speed transaction servers and high-end workstations.

Over time, faster and enhanced versions of existing PowerPC processors will
appear. We've already witnessed some of these enhancements with the 601+,
which uses the same 601 circuit design but a new process technology (the
complex manufacturing operation by which these chips are made) that both
shrinks the size of the circuits and enables the processor to be clocked faster
(up to 110 MHz). Another such improvement is the 603e, which was intro-
duced in March 1995 and features larger on-chip caches. It also has some
machine architecture improvements. While it uses the same process tech-
nology as its predecessor, the 603, the 603e sports a new, faster switching
transistor design. Also, certain load/store instructions on the 603e are
performance-tuned to operate in fewer clock cycles, and the speed or certain
math operations—notably the floating-point divide instruction—were
improved. The 603e presently can be clocked at 120 MHz, while the original
603 design topped out at 80 MHz. In August 1995, IBM and Motorola



disclosed a faster version of the 603e, called the 166 MHz 603e. In October
1995, an enhanced 604, the 166 MHz 604e, was disclosed. The same process
technology used to fabricate the 601+ was employed to reduce the size and
power consumption of these two processors, while boosting their operating
speed to 166 MHz. To learn more about the PowerPC family of processors
and their features, see Appendix A.

The PowerPC 601 (from now on, I'll just call it the 601) was the heart of
Apple’s first-generation RISC-based Macintoshes. These systems, mentioned
earlier, are called Power Macs to emphasize their performance. There are
three systems, and each targets a specific user (see Table 1.1).

Each system is built around one of the three standard model designs dis-
cussed earlier. Each Power Mac comes equipped with a base 8 MB of 80
nanosecond SIMM-mounted RAM, a hard drive, built-in Ethernet, and 16-bit
stereo sound hardware. The MacOS of these systems contain some impor-
tant elements. The first is AppleScript, a scripting language that automates
repetitive tasks or helps implement custom solutions using several applica-
tions. Next, there’s the QuickTime Extension for multimedia support. An
optional AV Technologies expansion board that provides video I/0 and
digital video capture can be plugged into the PDS slot on these systems.
Bundled with the AV boards is the PlainTalk voice recognition software and
the text-to-speech engine.

Table 1.1 An Overview of the First Generation Power Macintoshes

Power Macintosh 6100 7100 8100
| Pooosor  PowerPCEOT  PowerPCE01  PowerPCEOL
Speed 60/66 MHz 66/80 MHz 80/100/110 MHz
Cache optional optional 256 K standard
RAM 8 MB standard 8 MB standard 8 MB standard
DRAM expansion 72 MB 136 MB 264 MB
SIMM slots 2 4 8
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Standard 160MB to 250MB 250M to 500MB 250MB to 1G

HD configs

Floppy 1.4MB with DMA 1.4MB with DMA  1.4MB with DMA

CD-ROM Optional Optional Optional

DRAM video Standard Standard Standard

VRAM video 1 MB standard 2 MB standard

VRAM expansion 2 MB 4 MB

Standard support 1 monitor 2 monitors 2 monitors

SCSI High-speed High-speed High-speed asynch
asynch asynch Dual SCSI channels

Ethernet on-board with DMA channel, AAUI connector

16-bit audio stereo in/out with DMA

2 Serial ports—LocalTalk with GeoPort
compatible with DMA channel

Apple Desktop Bus (ADB for input devices)

The Power Mac 6100/60 takes aim at the low-end user by providing a RISC-
based Mac at a low price. It uses the Centris 610/Quadra 610 chassis, and the
601 processor is clocked at 60 MHz. The Power Mac 7100/66 uses the Centris
650/Quadra 650 chassis. With the 601 clocked at 66 MHz and three NuBus
expansion slots, this system should meet the mid-range computer user’s
needs.

The Power Mac 8100/80 stakes out high-end users, with its processor clocked
at 80 MHz for best performance. Its Quadra 800/840AV chassis contains
ample room for several high-speed SCSI hard drives, and memory can be



expanded up to 264M, which should satisfy the needs of the most demand-
ing power user. Both the Power Mac 7100/66 and the 8100/80 provide a
second monitor port, which you can use to expand the screen work area or to
run a different operating system on the second monitor. The only second-
generation Power Mac that uses a first-generation chassis is the Power Mac
8500/120, which is based on the Power Mac 8100. Power Mac 8100 users can
upgrade to this machine with a logic board swap.

The number after the slash in each Power Mac’s name denotes the speed of
its processor clock. This naming scheme enables faster versions of these
Power Macintosh systems to be shipped with the same name because only
the trailing digits change. This arrangement eliminates a lot of the confusion
created by the previous method in which minor changes to existing Macs
begat whole new model names. It also explicitly states the processor speed,
which is handy when comparing systems. Such was the case when Apple
introduced faster versions of these designs in late 1994 and early 1995. In
November 1994, Apple introduced the Power Mac 8100/110, which was
basically a Power Mac 8100 system using a 601+ pumped up to 110 MHz.
Just two months later, in January 1995, faster versions of the other systems
appeared, dubbed the “speed bump” systems because the system clock was
increased slightly. There is the 6100/66, the 7100/80, and the 8100/100, with
clock speeds of 66, 80, and 100 MHz, respectively. The 8100/110 still exists as
a top-notch system for those who need the performance and can afford to
pay the premium price it commands.

In May 1995, Apple began selling its first 603-based Mac, the Power Mac
5200. It features a unique chassis that melds a monitor with a stereo sound
system, floppy drive, and quad-speed CD-ROM drive into a single unit
mounted on a swivel stand (see Figure 1.1).

During the summer of 1995, Apple introduced the Power Macintosh 9500,
followed by the Power Mac 8500, 7500, and 7200 series in August. They
represent Apple’s second-generation Power Macintosh architecture. This
architecture features many improvements to boost performance. The
memory subsystem uses interleaving on some models to boost memory
access rates, and the memory controller is smarter about handling data
traffic. The architecture has numerous DMA channels that manage data
transfers among the various I/0 subsystems such as the network, SCSI, and
video capture (on those systems, such as the Power Mac 7500 and 8500, that
are equipped with AV technology).
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7200 Model

TR

5200 Model

— 9500/8500 Model

Figure 1.1 The Power Mac 5200 system.

These systems use Open Transport, a Unix standard for network and
communications. With Open Transport, Apple uses a standard set of pro-
grammer interfaces to implement their network protocol stacks, network
interfaces, and serial communications. It also allows future growth paths
for supporting PCI network cards such as 100M Ethernet and ATM.

These second-generation systems no longer use NuBus expansion cards.
Instead, hardware expansion is handled by another industry standard, the
PCI bus. The PCI bus is known for its throughput and plug-and-play capa-
bilities. In fact, a properly designed PCI card is platform agnostic; it can be
plugged into either a PC or a Power Mac, and it operates.



Future Directions

The up-and-coming PowerPC CHRP standard allows future IBM and Power
Mac systems to run several different operating systems (but not all at
once). A crucial capability to support this is that a CHRP system can cold
boot into the Mac OS, Windows NT, or OS/2 Warp, and all of the PCI
expansion cards in the computer’s slots will function with the currently
running OS. This is possible because the PCI bus design enables the boot
process to detect and load the appropriate drivers from the expansion
card'’s firmware.

The other important capability that allows a CHRP system to host various
operating systems is the PowerPC processor is a bi-Endian processor. That
is, it supports the two different memory addressing schemes used in the
industry. It would be difficult, if not impossible, for a computer to host
operating systems that used such disparate addressing modes unless such
support was provided in the processor itself. If you're not sure as to what
an Endian addressing mode is, relax. You normally won't have to deal with
such issues unless you plan to port the code to another platform, such as
a PC or Unix system.

The design of the second-generation family Power Macs, like its predeces-
sors, centers around three basic models, as shown in Table 1.2. Each comes
equipped with a base 8 MB of 70 nanosecond RAM, a hard drive, two built-in
Ethernet ports (one 10BaseT connector, and one AUI connector to handle
other types of Ethernet cabling), and 16-bit stereo sound hardware.

Table 1.2 Overview of the Second-Generation Power Macintoshes

Power Macintosh 7200 7500 8500 9500
Speed 75/90 MHz 100 MHz 120 MHz 120/132 MHz
Cache . optional optional 256K standard 512K standard



DIMM slots 4 8 8 12

Expansion Slots 3 PCI 3 PCI 3 PCI 6 PCI

Standard HD configs 500 MB to 1GB 500 MB to 1GB  1GB to 2GB 1GB to 2GB

Floppy 1.4M 1.4M 1.4M 1.4M
with DMA with DMA with DMA with DMA
CD-ROM Standard Standard Standard Standard

VRAM video 1 MB standard 2 MB standard 2 MB 2 MB (via PCI
card) standard
VRAM expansion  2/4 MB 4 MB 4 MB 4 MB
Standard support 1 monitor, 1 monitor, 1 monitor, 1 monitor, via
built-in built-in built-in PCI card
SCSI Internal Internal fast Internal fast Internal fast
standard
External External External External
standard standard standard standard

Accelerated graphics Composite and S-video Composite and S-video
Accelerated graphics

built in input input/output on PCI card

Logic board Plug-in Plug-in Plug-in
swap

Ethernet on-board with DMA channel, 10BaseT and AAUI connector

16-bit audio stereo in/out with DMA
2 Serial ports—LocalTalk with GeoPort
compatible with DMA channel

Apple Desktop Bus (ADB for input devices)




The Power Mac 7200/75, 7500/90, and 7500 use a new low-cost chassis
design based on the popular Quadra 630. This chassis resembles a tall,
beveled pizza box that provides ample room for several PCI cards and the AV
hardware that’s present on the Power Mac 7500. Currently, the 7200 series is
the low-cost system for the home market. The 7500’s built-in AV features and
higher performance gear it toward small and mid-sized businesses. The
Power Mac 8500 borrows the Power Mac 8100’s mini-tower chassis. Its high-
speed 604 makes the 8500 useful for the large office, serving the needs of
technical and power users. Folks doing multimedia authoring enjoy this
system’s built-in AV capture and display capabilities. While the 9500’s
chassis closely resembles the 8100’s, it’s roughly 2.5 inches taller, to accom-
modate the six PCI slots and the expansion bays for SCSI peripherals. This
generous expansion capacity and fastest 604 processor speed makes the 9500
suitable for high-end publishing and graphics, media authoring, software
development, and other jobs where the utmost in performance is required.
The 7500, 8500, and 9500 house the PowerPC processor on a plug-in card.
This enables you to swap the processor for a faster one when your work load
demands it. The hardware in these systems can handle up to a 150 MHz 604
processor in the system.

/ Important

These second-generation systems use a different type of RAM. First
' generation Power Macs use 72-pin SIMM-mounted RAM. The second-
generation systems use 68-pin DIMM-mounted RAM. If you're planning to
upgrade an existing Power Mac to a second-generation system, you'll
either have to budget for new memory, or obtain Newer Technology's
DIMM Tree, a gadget that lets you protect your memory investment. The
DIMM Tree has SIMM sockets that accept your existing RAM, while the
device itself plugs into one of the DIMM sockets on the main logic board.
Your SIMM RAM must have a 70 nanosecond access time or better to be
used this way.

As mentioned earlier, because these computers use a PCl expansion bus,
you'll have to replace any NuBus boards that you own.




In August 1995, Apple also introduced a line of PowerPC-based notebook
computers. The PowerBook 5300 series is Apple’s all-in-one notebook, so
named because it can function as a mobile desktop system. It has a large LCD
screen (10.4 inches for color screens), a built-in storage bay for a floppy drive
or other storage media, a PCMCIA slot that accepts two Type II or one Type
III PCMCIA cards (aka PC Cards), a SCSI port, a serial port, and an ADB
port—in short, almost a full complement of desktop system capabilities. The
Duo 2300 is a light-weight subnotebook computer with minimalist I/O
capabilities. It has a RJ-11 socket for an internal modem, and a serial port that
can function as an external modem port, printer port, or LocalTalk network
connection, depending upon the system settings. For additional I/O capabili-
ties, docking connectors can be attached to the computer, or it can be parked
in a docking station. Both PowerBooks use electronic trackpads instead of a
mechanical trackball as a reliable pointing device, and a PowerPC 603e
processor for high performance and long battery life (see Figure 1.2).

Figure 1.2 The PowerBook 5300 and Duo 2300.

As nice as these systems are, you might suspect that there’s a catch, espe-
cially regarding software compatibility. After all, didn’t Apple and the others
sacrifice the existing software base on the altar of performance? Apple tries
to let you have your cake and eat it too by placing a 68L.C040 emulator in the
ROMs of these systems. This emulator is a sort of “virtual” 68040 processor
that can execute the 680x0 code in existing Mac applications without modifi-
cation, but this emulator doesn’t support the 68040’s floating-point unit
(FPU) and memory management unit (MMU) instructions. (Only very
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eclectic utility applications would ever try programming a processor’'s MMU,
and such code won’t work anyway with the Power Mac’s vastly different
memory architecture.) The emulator is complete in every other detail, so it
can run the bulk of the existing 680x0-based Mac applications and utilities.
Lack of an FPU in the emulator might or might not be a problem, depending
upon how smart the application software is in dealing with the machine
environment. If the application simply expects an FPU, it will crash. Some
applications detect the absence of an FPU, and either refuse to run or will do
their own computations in software. This slows down the application signifi-
cantly because such software computations run in the emulator. Those
applications that use Apple’s math routines will run somewhat faster be-
cause portions of these routines were rewritten as PowerPC code.

One reason the emulator works is because of the virtual machine defined by
the Mac Toolbox routines. Recall that Mac applications obtain system
services (such as reading a file and drawing to the screen) through the
Toolbox, and these Toolbox calls act as well-defined entry points into the
operating system. What Apple accomplished with the Power Macs was to
literally slide a RISC processor into the system and then use “native” (that is,
PowerPC) Toolbox code to handle the application’s requests. The Mac OS,
for example, provides a set of screen drawing primitives known collectively
as QuickDraw. An application’s drawing functions that use QuickDraw on a
680x0-based Mac continues to work on a Power Mac without recompiling
the application. That’s because the Power Macintosh ROMs present an
identical QuickDraw interface to the application, even though this version of
QuickDraw is written in PowerPC code. Whatever application code isn’t
using the Toolbox gets executed by the emulator.

This is a simplified explanation of the situation, of course. The Power Mac'’s
operating system has to know at any given moment whether it's emulating a
680x0 processor or running native PowerPC code. This is a serious problem
because not only is the instruction set different, but the system environment
for each processor is different. There are all sorts of system variables, argu-
ments pushed on the stack, and other elements that have to be accounted for
when execution switches from the emulated 680x0 processor environment to
the PowerPC processor environment and back. A Mixed Mode Manager built
into the ROMs along with the emulator manages this context switch. It keeps
track of what processor environment the application is currently in, switches
the context to the different environment when required, and makes any
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necessary adjustments between the two. Such adjustments might pass a
drawing request to the native Toolbox code, while another adjustment might
communicate the result of the request back to the calling program. For the
most part, Mac programmers won'’t have to concern themselves with how
the Mixed Mode Manager works, but there are exceptions. I'll cover them
when we get into Power Mac-specific features in Chapters 4 and 5.

For those of you still waiting to hear about a catch in this setup, here it is. The
emulator—not surprisingly—musters only the performance of a fast 68030 or
slow 68040 processor. Performance varies, depending upon how often the
680x0 application calls the Toolbox routines written in PowerPC code.
Because Apple estimates that Mac applications spend 60 to 80 percent of
their time in Toolbox code, it’s possible that a 680x0 application runs faster
than emulated speeds because it spends most of its time actually running
native Toolbox code rather than running as emulated 680x0 code. The
performance question is complicated by the fact that, for compatibility
reasons and time to market issues, Apple hasn’t yet ported all several thou-
sand of the Toolbox calls to PowerPC code. 680x0 Toolbox routines that
weren’t ported get handled by the emulator. In some cases a call to the
Toolbox might execute native code, resulting in a brief performance boost,
while another Toolbox call might continue through the 680x0 emulator,

for a performance hit. It’s also important to note that the overhead of the
Mixed Mode Manager handling numerous context switches can degrade
performance.

So are these Power Macs faster or not? Yes, they're faster. The emulator and
Mixed Mode Manager provide compatibility for existing software. They serve
as a bridge that allows 680x0 applications to run until the real solution
arrives: these same applications written in native code. For such native
applications, the overhead of the emulator and Mixed Mode Manager
practically disappears, with the exception of those Toolbox routines still
implemented as 680x0 code. Over time, applications will run even faster as
more of the Mac Toolbox is rewritten as PowerPC code. You can expect
future releases of the Mac OS to replace more of the 680x0 portions of the
Mac OS with native code, yielding better performance. Early reports, how-
ever, indicate that despite the mixture of 680x0 and PowerPC Toolbox code,
Mac applications recompiled into native code run very fast on the Power
Macs. On the low-end Power Mac 6100/60, such native applications run at



Intel Pentium speeds. These same programs run nearly twice as fast on the
Power Mac 8100/80.

The second-generation Power Macs are a clear step further along the path
toward rewriting the Mac OS completely in PowerPC code. This version of
the Mac OS, System 7.5.2, has some of the Managers, (such as the Resource
Manager), some device drivers (such as the SCSI driver), and the network
protocol stacks rewritten native code. Those portions of the Mac OS already
native (such as QuickDraw, the math libraries, and the Memory Manager)
have been tuned for better performance. Finally, the 680x0 emulator has
been revised to enhance performance. First, it’s been tuned for the 603 and
604 processor architecture. Second, it now uses dynamic recompilation to
“compile” frequently executed sections of 680x0 instructions in native code,
rather than use the brute-force technique of interpreting each 680x0 instruc-
tion over and over again. It does this by monitoring the addresses of 680x0
branch instructions and creates a history table. The history table lets the DR
emulator recognize frequently executed sections of 680x0 code (typically
code loops). Each 680x0 instruction acts as an index into a look-up table of
functions, and each function produces a corresponding set of native instruc-
tions. These code blocks get placed in a 512 KB cache and the emulator uses
the history table to reroute the course of execution to the cached native code
blocks. To minimize overhead, the cache has a simple management algo-
rithm: once it fills, it is purged and the DR emulator begins refilling it. This
results in better performance for both 680x0 and native applications because
the latter still rely on portions of the Toolbox that are 680x0 code. In terms of
performance, the new “DR” emulator boosts application speeds by 15 to 35
percent, on average. Combined with the faster SCSI and smart I/0, these
systems are very fast. Even emulated 680x0 applications now readily out-
perform the fastest 68040 system by a wide margin. However, even better
performance is possible by using a native version of the application.

@ Future Directions

A future version of the Mac OS (code named Copland) will be mostly
native code and thus will offer even better performance than is available
with the hybrid-code version of the Mac OS today. Its preemptive
multitasking kernel will schedule program activity so that the processor is
used effectively, realizing even better performance. The kernel's task
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scheduler, for example, will transfer execution from a program waiting for
I/0 (say, a disk read) to one that's processing a complex computation, or
to one that needs to write to the network. It also will offer better reliability
because Copland will use a limited memory protection mechanism to “wall
off" the microkernel, device drivers, and Copland-specific background
programs from misbehaving applications.

Time for a Change (to Power Mac)

To make the switch to native Power Macintosh applications, programmers
need development tools that can compile their existing application code into
PowerPC code. Although many different development tools are available, the
best possible situation would be tools that run on both 680x0 Macs and
Power Macs. Source code that you wrote and tested on a 680x0 Mac could be
copied to a Power Mac and easily recompiled, making the initial application
port to the PowerPC a snap. (Note: those applications that are fine-tuned to
the 680x0 run-time environment will require some adjustments or even a
major redesign.) The result is a pair of applications, each of which runs on
680x0 Mac or a Power Mac. With some additional work, you could combine
the code in these two applications to make a fat binary application, one that
could run on both types of Macs. Or, if the target audience is just Power Mac
users, you’d simply write your source code on the Power Mac. Application
testing and maintenance would be further simplified if these tools also
provided a source code level debugger.

Such development tools exist. It’s time for you to meet Metrowerks
CodeWarrior, and use it to write some programs.



Beginning
Programs

Beginning Programs

This chapter is for the novice programmer. It shows you how to use
the ANSI C Standard Libraries supported by the Metrowerks C
compiler to do simple tasks on the Mac. The interface for these
programs won't be pretty, given that the ANSI Libraries stem from
Unix’s character-based heritage. The goal here, however, is func-
tion, not appearance. These libraries provide a safety net that you
can rely on as you explore the Mac’s Toolbox and operating
system.



As an aspiring Mac programmer, you've no doubt heard this often-quoted
maxim about the Mac: “Easy to use, hard to program.” Why is this? If you've
already leafed through the half-dozen or so volumes of Inside Macintosh, you
might even know the answer to that question.

Out of this wealth of information, where do you start? Put another way, how
do you determine which Toolbox calls to use when starting an application
and which ones to call to access services provided by the operating system?

About the Toolbox

The Mac Toolbox and operating system provide more than 4,000 routines, of
which about several hundred are commonly used. The Mac is a complex
gestalt of these routines and data structures that you must understand fairly
well to write a program. How do you know which routines to use? After all,
you must understand how to initialize the application’s environment so that
these routines function, how to plug the application into the operating
system so that it coexists and cooperates with fellow applications, and last,
but not least, how an event-driven interface works. This seems like a rather
dismal attitude to take for a book on Mac programming, but I'd rather you
appreciate that there’s a lot to learn just to get started in Mac programming
than get frustrated and give up entirely.

Background Info

So that you don't get confused later when | start talking about calling ¢
functions, let's make a distinction between those functions our program
uses, and those belonging to the Mac Toolbox/0S. Following /nside
Macintosh conventions, I'll use the term routine to indicate Toolbox
functions.

Having said that, now I can say it’s not impossible to learn how to program
the Mac. The trick is to limit the unknowns you’re dealing with so that you
can break the job into smaller, manageable portions. Fortunately,
Metrowerks CodeWarrior provides a way to limit the problems you face, as
you'll see in a moment. Another way to deal with some of the unknowns is to



have plenty of source code examples handy. This way you can learn how
particular routines operate and when to use them. I'll help you here by
supplying some working code examples, which you’ll find on the CD.

Munge It

I firmly believe in learning by doing, so let’s start by solving a problem. One
of my jobs as a technical editor is to take manuscripts and edit them. I clarify
certain points in the manuscript, reorganize the flow of thought, request
missing material, and perform other editorial tasks. I receive these manu-
scripts as ASCII text files sent via electronic mail (email) on the Internet or
other online services. Ideally, I get a manuscript file and simply start editing
it in a word processor. In reality, sometimes there are problems.

Most word processors, both Mac and PC, use a carriage-return (CR) charac-
ter to end a paragraph of text. This allows the word processor to neatly
“wrap” or fit the text on the screen as you add or eliminate words inside the
paragraph. Some word processors, however, save the text with CRs at the end
of each line. The text looks fine—until you have to change the manuscript
using a different word processor. Because of the extra CRs, the word proces-
sor can’t wrap the words, and you wind up with a mass of jumbled text. The
author probably meant well, but the editor now has to laboriously prune
those spare CRs from the text, line by line. This type of file is a headache for
me to edit.

After hacking away at one long manuscript for over an hour, I decided that
this chore was a great job for the Mac to handle. I'd write a Mac program to
munge, or hack out, those extra CRs for me. Basically, the program would
read an input file, filter out most of the CRs, and write the rest of the data to
an output file. Thinking more along the lines of how the computer has to do
it, the program reads a byte—or character, actually—from the input file,
examines the byte, and if it passes muster (it's not a CR), writes the byte to an
output file. If the byte is a CR, it’s tossed into the bit bucket instead. If the
program detects the end of a paragraph (a double CR, or a blank line), then
the end of paragraph (the double CR) is written to the output file. This makes
the resulting output ASCII text organized the way a word processor expects
it. Stated this way, the problem seems easy enough.



Now here’s where CodeWarrior helps. Metrowerks CodeWarrior supports the
ANSI C Standard Library, which is based on the Unix C function libraries.
These libraries supply functions that handle file I/0 and provide an interac-
tive console where you enter commands and get screen output. Because
these functions originally were implemented on old Unix systems, they
typically deal with character-based I/0. This doesn’t make for a nice Mac
interface, but it lets you concentrate on the problem without having to learn
lots of Toolbox routines all at once.

/ Important

CodeWarrior's console 1/0O provides support for the C Standard Library's
' stdin, stdout, and stderr Streams. It opens a virtual console window where
all these streams are directed. The console window is set up and managed
by CodeWarrior's SIOUX (Simple Input/Output User eXchange) library,
which must be linked to an application. The CodeWarrior IDE can auto-
matically include the SIOUX and several other C libraries in a new project
file, sparing you the trouble of adding them yourself. It does this by draw-
ing information from a Stationary file that you pick when creating a new
project. Stationary files act as templates. These templates have built-in
references to the most often-used libraries for certain types of projects.
Most of the Stationary files include the ANSI C libraries by default. If you
don't want to use the ANSI C libraries, pick one of the “minimal” Station-
ary files when you create a new project.

Getting Started

Let’s get started by launching the CodeWarrior C compiler, or more accu-
rately, the application that manages it. The easiest way to do this is to go
inside CodeWarrior folder, open the Code Examples PPC folder, followed by
the Munger folder, and double-click on the file “munger.c.” After a short
delay, a window opens, displaying C code. This window belongs to the built-
in editor that’s part of CodeWarrior’s Integrated Development Environment
(IDE). The CodeWarrior IDE application hosts and seamlessly combines all
the development tools that you'll need—editor, C compiler, resource com-
piler, and linker—to write Mac programs. Within the editor’s window, you
should see the following code:



#include <stdio.h>

#define CR 0x@D
#define LF 0x0A

FILE *istream, *ostream;

void main (void)

{

short crflag;

long icount, ocount;

char ifile[64], ofile[64]; /* Path names must be 64 chars or less */
int nextbyte;

printf ("Enter input file: ");
gets (ifile);

if ((istream = fopen(ifile, "rb")) == NULL) /* Open the file OK? */
{
printf ("\nError opening input\n"); /* NO, say so */
return; /* Bail out */

} /* end if */

printf ("Enter output file: ");
gets (ofile);

if ((ostream = fopen (ofile, "wb")) == NULL) /* Can we write an output file?*/
{
fclose (istream); /* NO. First close input file */
printf ("\nError opening output\n®); /* then warn, and bail out */
return;

} /* end if */

icount = oL; /* Set counters */
ocount = 0OL;
crflag = 0;

/* Read char.s until end of file */
while ((nextbyte = fgetc (istream)) != EOF)

{
icount++; /* Bump input char counter */
switch (nextbyte) /* What char was read? */

{
case CR:
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if (crflag >= 1) /* Two in a row, end of paragraph */
{
fputc(nextbyte, ostream); /* Write two CRs to the output */
fputc(nextbyte, ostream);
crflag = 0; /* Reset the flag */
ocount++;
} /* end if */
else
crflag++; /* Bump the flag, and toss the CR */
break; /* end case CR */
case LF: /* Toss LF, but don't touch crflag */
break; /* end case LF */
default:
fputc (nextbyte, ostream); [* All other chars get written */
ocount++;
crflag = 0; /* Clear the flag */

} /* end switch */
} /* end while */
fclose (istream); /* Clean up */
fclose (ostream);
printf ("Bytes read: %ld\n", icount);
printf ("Bytes written: %ld\n", ocount);
} /* end main () */

Let’s take a closer look at this code.

The Code Tour

The munger program first prompts for an input filename, using the printf ()
function to put a message in a console window made by the C Standard
Library. It uses gets() to read the keyboard when you type in a filename and
press Return. Your input is placed in the array ifile. Note that ifile and ofile
are 64 characters long. If you're opening files with long names, or the file is in
a folder with a long name, you need to increase the sizes of the ifile and ofile
arrays so that the pathname fits.

Background Info

A pathname is the complete description of where a file is located on a
particular hard drive or volume. It's a string of characters that incorporates
the volume's name, the filename, and the names of those folders within




which the file is nested. This might sound overly complicated until you
realize that you might have two files named “Résumé” on the same hard
drive, but in different folders. As an example of a directory pathname
description, consider the following. If a Mac's hard drive is named Tachyon,
and a file “Read Me" is in the folder New Info, the pathname for the file is
Tachyon:New Info:Read Me. Another “Read Me" file, located in the folder
named Stufflt, that in turn is inside another folder called Aladdin Docs,
would have the pathname Tachyon:StuffIt:Aladdin Docs:Read Me. This
convention is similar to DOS/Windows pathnames, but instead of a
backslash (\), the Mac OS uses colons as separators between the drive,
folder, and filenames. This convention also explains why you can't use a
colon in a filename.

Next, the program uses fopen () to open the file:

if ((istream = fopen(ifile, "rb")) == NULL) /* Open the file OK? */
{
printf (“\nError opening input\n"); /* NO, say so */
return; /* Bail out */

} /* end if */

Note that you check to see if this open operation fails. If it does fail, the
program halts. With the minimalist input provided by the C Standard Li-
brary, it’s quite possible for you to mistype the filename, which creates an
error condition when fopen() fails to open the file. The program then uses
similar code to set up the output file and checks for trouble as it does so. This
is a good time to emphasize that no matter how simple or complex your
program is, always, ALWAYS, ALWAYS, check for errors. You can eliminate a
lot of crashes, trashed hard disks, and needless debugging by having your
program determine if the routines it calls complete successfully.

The heart of the program is the while loop, which reads a stream of bytes from
the input file and processes them. The switch statement inside the loop
determines the fate of the byte under scrutiny. Any character other than a CR
or linefeed (LF) falls through to the default case, which writes the character to
the output file. Because I get lots of files from PCs, and DOS ASCII text files
use a LF-CR combination to end each line, the program also filters out any
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LF characters it happens to find in the character stream. The program
handles this filtering operation with the LF case statement, which simply does
nothing, and as a consequence the LF never gets written to the output file.

Now to those CRs, which are handled by the case statement:

case CR:
if (crflag >= 1) /* Two in a row, end of paragraph */
{
fputc(nextbyte, ostream); /* Write two CRs to the output */
fputc(nextbyte, ostream);
crflag = 0; /* Reset the flag */
ocount++;
} /* end if */
else
crflag++; /* Bump the flag, and toss the CR */

break; /* end case CR */

The program logic works on the assumption that most folks separate para-
graphs with a blank line. This means that the last line of the paragraph ends
with a CR, which is followed immediately by a blank line composed of a
second CR. So when the program encounters the first CR character, it gets
tossed into the bit bucket and the flag crf1ag is incremented. If a character
other than CR is read next, the program clears crf1ag. This handles situations
where the CR just terminates a line of text. Notice the exception here: A LF
character doesn't reset crflag because it occurs jointly with the CR in DOS
files. When a second CR in a row occurs because of a blank line, the if
statement detects that crflag is set. The code now writes two CRs to the
output file to ensure the line break between paragraphs. Of course, we clear
crflag to begin the search for the next paragraph ending.

Finally, the program closes both files and writes a summary to the console
window of the bytes read and written, as tallied by the counters icount and
ocount. Because the program’s function is to throw away bytes, fewer bytes
should have been written than read. It’s not necessary to do this, but the
summary serves as a sanity check on the program'’s operation, which is
reassuring to me. It’s possible to defeat the paragraph detection logic by
submitting an ASCII text file with no blank lines between each paragraph,
but I can add 30 to 70 blank lines to a manuscript within minutes, while
manually stripping CRs from over several hundred lines takes up to an hour.



Important

The text of this book was written using the full version of Metrowerks

CodeWarrior. You'll have to use slightly different steps when using '
CodeWarrior Lite from the CD. The commands New, New Projects, and
Add File... are not available. Because of these limitations, it can only work
with the sample files provided on the CD.

So, if you are following along using CodeWarrior Lite, when the text tells
you to use the New, New Project.., or the Add File.. command, you should
instead open the related project file and keep it open throughout the
exercise. All the associated files will already be in the project, so you won't
need the Add File.. command. Then, you can follow the same procedures
as if you were using the full version of CodeWarrior.

Making Munger

Let’s make this file munging program. You've opened the file “munger.c,” so
the next step is to make a project file for it. From the File menu, select New
Project..., type Munge.u (you get the p character by typing Option-M) for the
project name into the Standard File dialog box that appears.

There’s an informal convention where you denote a project file by attaching
either a . or .m, or .prj extension to the filename. Use of the .w extension (the
character is made by typing Option-P) is common among THINK C program-
mers, while CodeWarriors favor the .u extension (as mentioned, made by
typing Option-M). This naming convention isn’t required, however. You can
use any extension (or none) if you want, but if you're working with other
programmers or plan to share code with other users, these conventions help
identify the project file for them.

Take note of the Project Stationary item that appears in Standard File dialog
window. This popup menu lets you pick from various Stationary files. These
files preconfigure the settings of the project file that you're making. Hold
down the mouse button on this popup menu and pick the item Mac OS PPC
C/C++.u. Now hit Return or click the Save button.

Now a project window appears, and its window title matches the name of the
project file you just entered. This project window displays and manages the




several types of files that make up the project, and ultimately, a Mac pro-
gram. There’s a Source entry for source code files, a Resources entry keeps
track of the resources associated with the project (if any), and there are
entries for the program’s libraries, which are divided into Mac OS libraries
and ANSI libraries. In some of these categories, default filenames are pro-
vided. It supplies InterfaceLib, MathLib, and MWCRuntime.Lib, for example,
as the default Mac OS libraries. The project also has set up some default ANSI
C libraries, whose entries you'll change in a moment. First, click on the
Sources entry to highlight it. Now choose Add File... from the Project menu.
In the Standard File dialog box that appears, locate the file “munger.c” and
click on the Add button (see Figure 2.1).
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Figure 2.1 Adding “munger.c” to a project.

The Add button dims, and next you click on the Done button. The source file
“munger.c” is added to project Munger.u. You added this one file, and—
surprise!—it’s time to delete some surplus entries from the project. First,
select the <replace me Mac>.c entry in the window’s Sources category by
clicking on it. Next, go to the Project menu and pick Remove Files. Repeat
these steps for the <replace me>.rsrc from the Resources category. You
removed these items because they simply acted as placeholders for your own
files. Also, your first programs won'’t be using resources anyway. (If you're
wondering what a resource is, hold tight until Chapter 4.) Now go to the ANSI
Libraries category and click on the arrow to expose the files kept in this



section. Highlight the entry ANSI C++PPC.Lib and again chose Remove Files.
After you've made these changes, the Project window appears as shown in

Figure 2.2.
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Figure 2.2  Changing the library files in project Munger.p.

You're not done yet. Select Preferences... from the Edit menu. Scroll to and
click on the C/C++ group icon. In the panel that appears, ensure that the
checkbox for Require Function Prototypes is set (see Figure 2.3). This setting
demands that you declare each function, specifying the function’s number
and type of input arguments and the type of the result (if any). This can catch
potential problems that can occur when you call the function with a set of
arguments different from what it expects. This might happen because you're
modifying the function, or inadvertently passed the function an argument of
the wrong type, as when you call a Toolbox routine. In either case, checking
Require Function Prototypes nails this error at compile time. Otherwise,
when the program runs, such improper function calls might cause a crash. I
also delete the MacHeaders.h precompiled header filename from the Prefix
File Item because my work often involves parts of the Mac OS that aren’t
normally in the precompiled header file.

Next, go to the C/C++ Warnings group and click on Unused Variables,
Unused Arguments, and Extended Error Checking. Like Require Function
Prototypes, you actually don’t need these settings for this project, but
because they enforce good programming practices, you ought to get into the
habit of setting them now. The unused variables/arguments settings typi-
cally catch “dead code,” such as a local variable whose code you eliminated
from a function, but forgot to remove its storage declaration. Extended Error



Checking uses stricter type-checking rules when compiling the C code,
flagging subtle code goofs. The C compiler, for example, issues a warning if a
non-void function doesn’t have a return statement, or a value isn’t passed to
the return statement.
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Figure 2.3 Setting the C/C++ preferences for project Munger.p.

Now scroll to the PPC Linker group icon and click on it. In this group’s panel,
go to the Entry Points section. We're just going to check the default functions
that get called when our program initializes, starts, and exits. These func-
tions, which are part of the Power Mac run-time architecture, get called
when a native program launches and quits. Both the Initialization and
Termination items in this panel should be blank (see Figure 2.4). The Main
item has a function name of __start. This function is responsible for calling
our program’s main() function. This is the default situation for an application;
it usually doesn’t require any special initialization or termination processing.
The Mac OS normally handles any set up or house-cleaning when your
application launches and quits. For shared libraries, the Initialization and
Termination items have the function names __initialize and _ terminate,
respectively. When the Mac OS loads the shared library, it calls these func-
tions to handle any special processing the library requires, such as allocating
and subsequently releasing a large block of memory.
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Figure 2.4 Checking the entry points for the project.

Finally, go to the PPC Project panel and type munger for the application name
into the File Name text box (see Figure 2.5) and click on the OK button. Click
on the Toolbar’s Make button or select Make from the Project menu, and let
CodeWarrior go to work on the project. If there are no problems, processing
statements from the compiler and linker briefly appear in the Toolbar’s
status area. An application named Munger is created.

Apply to open project.

Project Type: | Application |
~ Application Info:

File Name [Munger ] |

'SIZE' Flags [¢] Creator (7?77
Type |APPL
Preferred Heap Size (k) |384
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Figure 2.5 Setting the name of the application file that the project makes.
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Running Munger

Suppose that on a Mac hard drive named Tachyon, in the CodeWarrior tools
folder called CodeWarrior, there’s a folder named Code Examples PPC,
followed by a folder named Munger. Inside it is a text file called
“PowerPC.txt.” Suppose “PowerPC.txt” is loaded with surplus CRs. First,
open the file in MacWrite Pro and examine the file with the Show Invisibles
set in the View menu. Show Invisibles displays all the characters in the file—
including invisible control characters such as CR—instead of just text char-
acters. In Figure 2.6, you can see that each line ends with a small bent arrow
symbol; they represent CRs. If you don’t have MacWrite Pro, don’t worry:
other word processors also can display such “invisible” characters. Check the
documentation for your word processor for details on how to do this.

| ® File Edit Font Size Style Format Frame Uiew
=—————————— PowerPC.txt (Converted)

IBM-and Motorola-announce first:silicon-on-PowerPC-6034 I
d

Atthe Microprocessor-Forum today-1Bm-and Motorola jointly-+
announcedthe firstfabrication-of the second-PowerPC-RISC-
microprocessor, the-603. This-was-achieved-lessthan-12-«
months-after-announcing-initial-silicon-onthe-PowerPC-601.-«
The-PPC 603 provides-highperformance while-consuming:-little -«
power, making-itideal for-notebook-computer-designs.«

d

The PPC-603-uses-3.3-Y,-0.5micron, 4-level metal, static-«
CMOS technology to-pack-1.6million transistors -onto a-die-«
that's-7.4mm-by-11.5mm.-By-contrast, the-PPC-601-uses-3.6-«
¥,-0.6:micron-static-CMOS to-place-2.8-million transistors-on-a-«
die-120mm-square.-Like the-PPC-601, the-PPC-603-4
implements-a-32-bitversion-of the-64-bit-PowerPC-

architecture, with-a-32-bitaddress bus-and-a-32--or-64-bit-data-«
bus.-ltuses the-same superscalar-design-with-3-instruction-«
dispatch.-However, the-PPC-603-does differ-from-the-PPC-601 -«
in-severalareas.-First, the PPC-603-uses-a-Harvard-architecture:«
it-has two-separate-8-KB-caches, one for-instructions, and-one -«
for-data.-Each-cache-has-its-own-MMU.-Both-caches are bwo-
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Figure 2.6 A sample text file, with CRs at the end of every line.

It’s time to set “munger” to work on this file and see what happens. Launch
“munger” from the CodeWarrior IDE by clicking on the Run button in the
Toolbar. A console window called munger.out appears. Type in the



pathname to the sample text file we examined earlier as follows:
Tachyon:CodeWarrior:Code Examples PPC:Munger:PowerPC.txt. of course, ifyour hard
drive name and CodeWarrior tools folder are named differently, you'll type
the appropriate names into the pathname. If you goof on the filename,
“munger” complains and the program stops. If the filename is OK, “munger”
asks for an output filename. Type a filename that uses the same file path,
such as Tachyon:CodeWarrior:Code Examples PPC:Munger:PowerPC.out. Press Return
and “munger” processes the file. You'll get a summary of the operation, as
shown in Figure 2.7. The munger.out console window remains present, and
you have to pick Quit from the File menu to leave “munger.” When you do
so, a dialog box appears that asks if you want to save munger.out’s contents.
Click on the Save button if the console window’s output is important to you.
Otherwise, click on Don't Save to discard the console window’s output. This
feature enables you to capture the output of a job as required. For lengthy
pathnames, as in the example, the SIOUX console window lets you copy and
paste characters. You only have to type in the pathname once for the input
file prompt, select this text with the mouse, copy, and then paste the bulk of
the pathname into the prompt for the output file pathname. Now all that’s
left is for you to type the name of the output file.

Enter input file: Tachyon:Codelarrior:Code Examples f:Munger f:PowerPC.txt _{_}_
Enter output file: Tachyon:CodeWarrior:Code Examples f:Munger f:PowerPC.out

Bytes read: 5567
Bytes uwritten: 5466

I

[BIE]

Figure 2.7 The console window of program “munger” after it processes a file.

Now if you open the resulting file “PowerPC.out” with your favorite word
processor, you'll see that “munger” did handle the surplus CRs (see Figure 2.8).



PowerPC Programmer’s Toolkit

| & File Edit Font Size Style Format Frame Uiew
| EE] PowerPC.out (Converted)

1BM-and-Motorola-announce firstsilicon-on-PowerPC-603+ L3
o

Atthe Microprocessor-Forum-today-1Bm-and-Motorola-jointly- announced the first:
fabrication-of the second-PowerP C-RIS C-microprocessor, the-603. This was-achieved-
lessthan-12months-after-announcing-initial-silicon-on the-PowerPC-601.. The-PPC-
603 provides-high performance while-consuming-little power, making-it-ideal for-
notebook computer-designs.«

d

The-PPC-603-uses-3.3-Y,-0.5micron,4-level-metal, static: CMOS technology to pack-
1.6:milliontransistors-onto-a-die-that's-7.4 mm-by-11.5mm.-By-contrast, the-PPC-601-
uses-3.6-Y,-0.6-micron-static: CMOS to place-2.8 million-ransistors-on-a-die-120-mm:
square.-Likethe-PPC-601,the-PPC-603-implements-a-32-bit-version-of the-64-bit:
PowerP C-architecture,with-a-32-bitaddress-bus-and-a-32--or-64-bit-data bus. |t uses-
the-same-superscalar-design-with-3-instruction-dispatch.-However, the-PPC-603.does-
differfromthe-PPC-601-in-severalareas.-First, the-PPC 603 uses-a-Harvard-
architecture:-it-has two separate-8-KB-caches,-one for-instructions, -and-one for-data.-
Each-cache-has-its-own-MMU.-Both-caches-are two-way set-associative and-use-an-
LRU-algorithm.-Next, the-PPC-603-has-5-independent-execution-units.-It-has the-same-
branch-prediction-unit{BPU), integer-unit(IU),-and floating-point-unit.(FPU), that-can-
dispatch-three-instructions simultaneously, the .same-as-the-PPC-601.-However, the-

Figure 2.8 The munged output file.

Where’s the Mac?

OK, so you got some C code to run on the Mac, but where is that easy-to-use
Mac interface? The point is that we got code running quickly without getting
mired in too many details. We let the C Standard Library handle the job of
initialization. It also provided I/0 through a Mac window masquerading as a
console window. The important thing to carry away from this exercise is that
you can use the C Standard Library to act as a scaffolding while you test
various algorithms and Toolbox calls. The programs you make this way
aren’t meant to be friendly, just useful enough to test code. We will start
adding our own Mac interface to our “munge” program in the next chapter.

Here’s another example where the C Standard Library pitches in while we
investigate some Toolbox routines. Under System 7, active applications are
called processes. Certain system services such as File Sharing, PlainTalk
voice recognition, the Express Modem, and the LaserWriter 8.3 background



Desktop Printer Spooler actually are processes themselves. These system
services don’t show up on the application menu, but they do operate quietly
in the background. As the Mac migrates to a preemptive multitasking OS,
processes will become even more important to the overall operating system
design. With that in mind, let’s take a closer look at processes.

Future Directions @
The future Mac OS that I'm talking about here is Copland. Copland’s

microkernel, drivers, and specialized background applications will run in a
separate memory space, protected from a malfunctioning application.
Programs that make use of the GUI must run together in another memory
space. This is because the QuickDraw code currently is non-reentrant (for
more information on reentrant code, see Chapter 4). Most of the processes
just described, however, don't use QuickDraw, and thus are ready to take
full advantage of the capabilities that Copland offers. But don't some of
these background services, such as PlainTalk and File Sharing, use Control
Panels, which in turn use QuickDraw? Yes, they do. However, each Control
Panel is simply a front end that, based upon the controls you set, sends
the appropriate messages to the background processes that do the actual
work.

Processes Revealed

The Mac OS allocates each process a partition in memory where it runs and
assigns it a unique ID number. This ID number is called the process serial
number (PSN) and it is used by the operating system to reference the process
and control it. Inside Macintosh: Processes documents a group of Toolbox
routines, known collectively as the Process Manager, that manage these
processes and supply information on them. To find out more about pro-
cesses, let’s examine another quick program. Go to the Code Examples PPC
folder, and open the Process folder. Double-click on the “process.c” file.

#include <processes.h>
#include <stdio.h>

void main (void)

{
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register int i;

ProcessInfoRec thisProcess;

ProcessSerialNumber process;

FSSpec thisFileSpec;

unsigned char typeBuffer[5] = {0};

unsigned char signatureBuffer[5] = {0};

thisProcess.processAppSpec = &thisFileSpec; /* Aim pointer at our storage */

thisProcess.processInfoLength = sizeof (ProcessInfoRec); /* Store record size */
thisProcess.processName = (unsigned char *) NewPtr(32); /* Allocate room for the name */
process.highLongOfPSN = kNoProcess; /* Clear out process serial number */
process.lowLongOfPSN = kNoProcess;

while (GetNextProcess(&process) == noErr) /* Loop until all processes found */
{
if (GetProcessInformation(&process, &thisProcess) == noErr) /* Obtain detailed info */
{
for (i = 0; i <= 3; i++) /* Copy type & sig info into string buffers */
{

typeBuffer[i] = ((char *) &thisProcess.processType)[i];
signatureBuffer[i] = ((char *) &thisProcess.processSignature)[i];
} /*end for */

printf ("Process SN: %1d, %ld, Type: %s, Signature: %s, Name: ",
thisProcess.processNumber.highLongOfPSN,
thisProcess.processNumber.lowLongOfPSN,
typeBuffer,
signatureBuffer);

printf (" %s \n", P2CStr(thisProcess.processName)); /* Now print the name */

} /* end if */

} /* end while */
} /* end main() */

This program uses the Process Manager to obtain information about all of
the processes running on the system. Notice that we include one more
header file, <processes.h>, to the source code. This header file defines the
Process Manager routines and a data structure called processInforec that acts
as a container for all of the process’ relevant information. The lines
thisProcess.processAppSpec = &thisFileSpec; /* Aim pointer at our
wstorage */

thisProcess.processInfoLength = sizeof(ProcessInfoRec); /* Store record size */

thisProcess.processName = (unsigned char *) NewPtr(32); /* Allocate room for the
wname */



process.highLongOfPSN = kNoProcess; /* Clear out process
wserial number */

process.lowLongOfPSN = kNoProcess;

are used to set up our local copy of processInfoRec, called thisProcess. Then

we direct pointers in thisProcess to the appropriate storage locations.
processAppSpec, for example, which contains the location of the file that
created the process, is aimed at thisFilespec. And processname, which holds the
process’ name, is directed to a chunk of memory allocated by newptr(), a
Toolbox memory allocation routine. Last, we clean out the PSN variables by
assigning knoProcess, which equals zero, to it.

Now we use a while loop that calls the Process Manager routine
GetNextProcess () repeatedly. cetNextProcess(), when called with a PSN of 0,
starts at the beginning of an internal list of PSNs maintained by the Process
Manager and returns the first PSN on the list. By passing each returned PSN
back to GetNextProcess() on subsequent tours of the loop, we walk this list and
use another routine, GetProcessInformation(), to grab information on every
process in the system. When getNextProcess() finally reaches the end of the
PSN list, it returns an error value and the loop completes.

While the loop cycles, GetProcessInformation() extracts in-depth information on
the current process and stuffs it into thisProcess. As usual, notice that we
check for errors. If cetProcessinformation() reports no errors after it completes,
we dump some of the information it gathered to the console window.

Gathering Processes

It’s time to compile the “process.c” program and see what it gathers. There
are seven steps, and they are nearly identical to the first program, “munger.”

1. Save the code (if you typed it in) into a file called “process.c.”

2. Create a new project called process.p. In the Standard File dialog
window, be sure to pick the Stationary file Mac OS PPC C/C++.u from
the popup menu. Add “process.c” to the project. Check that the usual
suspects, “InterfaceLib,” “MathLib,” “MWCRuntime.Lib,” “ANSI
C.PPC.Lib,” and “SIOUX.PPC.Lib,” are in the project. The Project
window should resemble Figure 2.9.

3. Set the PPC Language and PPC Warning preferences the same way you
did for the munger.y project.
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Figure 2.9 The Project window for the process program.

4. In the PPC Linker preferences panel, check the entry point settings. As
mentioned previously, the defaults for this program are fine, but you
should get into the habit of visiting this panel when we start writing
more capable Mac programs.

5. Name the output file Process in the Project preferences panel.

6. With all the preferences set, make the program.

7. Finally, pick Run from the Project window. The console window ap-
pears and displays information on each process’ PSN, type, signature,
and name (see Figure 2.10). Note the presence of our own program,

“Process,” as well as the CodeWarrior compiler, the Finder, the File
Sharing Extension, and other applications.

|E=———-————Process.out

Process SN: 0, 8192, Type: FNDR, Signature: MACS, Name: Finder __G_
Process SN: 0, 8193, Type: INIT, Signature: hhgg, Name: File Sharing Extension
Process SN: 0, 8195, Type: APPL, Signature: MPCC, Name: MW C/C++ PPC v1.0adpi
Process SN: 0, 8197, Tupe: APPL, Signature: MWPR, MName: Mackrite Pro
Process SN: 0, 8199, Type: APPL, Signature: zTRM, Name: ZTerm 0.9
Process SN: 0, 8200, Tupe: APPL, Signature: ????, Name: Process

J51]

Figure 2.10 The process program displaying all processes on the system.



A Word of Caution

As you can see, with the assistance of the I/0 functions provided by the C
Standard Library and SIOUX, you easily can delve into the Mac’s inner
workings. Even with all the Mac code I've written over the years, I still
frequently use the C Standard Library I/0 functions to quickly test code that
uses unfamiliar Toolbox routines. If you know that you’re going to be using
the ANSI libraries exclusively in your program, pick the Stationary file ~ANSI
PPC C/C++.p from the popup menu when creating the project file.

Hazard

Because the C Library, through SIOUX, does its own application initializa-
tion, you need to exercise caution when mixing this library with certain
Toolbox routines. For example, the printf() function has SIOUX create a
Mac window that mimics a console window. If your program happens to
initialize the Window Manager so that it can use a Toolbox routine, this
creates a situation where your initialization code butts heads with the
window data structures created by SIOUX, and causes a crash.

To avoid this pitfall, never match the I/O functions you use with the Mac
Toolbox with those of the C Library in the program. If you use QuickDraw
or Window Toolbox routines in your code, don't use the C Library functions
that require a console window. Or, if your program uses the C Library's file
I/0 functions, don't use Mac Toolbox’s file I/0 routines.

In CodeWarrior 1.3 (aka CW7), you can modify the behavior of SIOUX
such that you can actually initialize parts of the Mac Toolbox, add custom
menus, and even install your own event loop handler. To do this, you need
the include header file “SIOUX.h" in your source code, and change some
fields in a s1ouxsettings data structure. Here's an example where you set
up SIOUX to allow custom menus and your own event loop in a program:

#include <stdio.h>
#include <sioux.h>

void main(void)

{
SIOUXSettings.standalone
SIOUXSettings.setupmenus

FALSE;
FALSE;

continues
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continued

<program code>

} // end main()

Tread carefully, and consult the CodeWarrior documentation for more
information.

Just the Beginning...

In this chapter, you've seen how to build a practical application, leveraging
off the I/0 functions in the C Standard I/0 Library. We've outlined seven
steps required to build and run the application in Metrowerks CodeWarrior.
You also examined how to use the C Library to help us experiment with
various Toolbox routines in isolation. Now you can apply this knowledge to
learn how the Mac works, which ultimately assists you in writing Mac appli-
cations. Try some experiments of your own, and then proceed to the next
chapter where you'll write a full-blown Mac application.



Using the
Toolbox

At this point you should be comfortable with the
Metrowerks CodeWarrior integrated development
environment and how to create and manage a project.
In a jam, you can rely on CodeWarrior’s C Standard
Library to help you learn how to use new and unfamil-
iar Mac Toolbox and OS routines. Does this mean
you're ready to write a full-fledged Macintosh applica-
tion? Not quite. For novice Macintosh programmers,
there are a number of basic concepts to learn. These
include program initialization, resources, event
handling, and the structure of files. These concepts
cover a lot of ground, but I'll keep the information
doses manageable by introducing them in stages,
along with programs that demonstrate these aspects of
the Mac OS. Readers with intermediate Mac expertise
might want to jump to the back of the chapter and
study the code on Apple Events. The rest of us will
catch up with you later.



In Chapter 2, I mentioned a Process Manager. As you learned, it is a collec-
tion of routines that deals with processes, which are running applications. It
should come as no surprise that many of the Toolbox routines are organized
into groups of related functions, or Managers. The Event Manager deals with
low-level events such as-mouse clicks and keystrokes. A Memory Manager
has routines that allocate memory, release memory, and adjust the size of
the stack. A Window Manager provides routines necessary for the care and
feeding of windows, while a Font Manager deals with the various fonts you
see on the screen or use to print. The list goes on and on. One of the few
exceptions to this naming scheme is QuickDraw—the routines that handle
drawing on the screen or onto a page image bound for the printer. These
various Managers serve as libraries of routines available for your use.

Important

The Toolbox routines actually exist either as shared libraries or as functions
in the Power Mac's ROM. For 680x0-based Macs, entry into a particular
Toolbox routine is handled by a 680x0 processor exception, which then
jumps to a dispatch table. For the Power Macs, a Toolbox routine is
entered via a set of pointers called a transition vector. These transition
vectors are set up by the operating system when an application loads. If
you're wondering what an exception or transition vector is, never fear: the
details are explained in the next chapter.

What’s nice about this scheme is that it helps organize all of those thousands
of Toolbox routines. If, for example, you need a function that reads a file,
look at the File Manager routines. As a novice, you should spend some time
just browsing through Inside Macintosh. The new editions organize the
technical content by category, such as files, memory, text, and so forth,
rather than by volume number as they did in the past. This arrangement
helps you locate the various Managers by function. Along with the usual
reference information, the new editions of Inside Macintosh also include
some tutorial material. You might not understand all of the information
presented there (for now), but it will give you a good idea of what Managers
exist, and what they do. When necessary, I'll make reference to the appropri-
ate Inside Macintosh edition.
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Meet Some Managers

To get you used to the idea of Managers, start by writing the classic “Hello
world” program. This also will demonstrate how to initialize a Mac applica-
tion. Start by opening the Code Examples PPC folder. Now open the
MacHello folder and double-click “hellol.c.” Now let’s take a close look

at the code:

#include <Types.h>
#include <QuickDraw.h>
#include <Fonts.h>
#include <Windows.h>
#include <Memory.h>
#include <Events.h>
#include <OSUtils.h>

#define NIL oL
#define IN_FRONT (-1)
#define IS_VISIBLE TRUE

#define NO_CLOSE_BOX FALSE

Already you’ll notice that there are a lot more header files involved than just
using the Standard C Library’s <stdio.h>. That’s because the Standard C
Library includes every I/O function possible plus the kitchen sink. In con-
trast, each Toolbox Manager has a separate header file. This keeps both your
workload and the compiler’s at a manageable level. It means that you have
to be more aware of what routines you plan to use (yet another reason to
browse through Inside Macintosh).

Background Info

Like Symantec’'s THINK C, the Metrowerks CodeWarrior compiler uses a
special header file called “MacHeaders.h” whether you're generating 680x0
or PowerPC code. This file incorporates the most frequently used header
files, such as “QuickDraw.h,” “Fonts.h,” “Windows.h,” “Files.h,” and others.
“MacHeaders.h” references a precompiled processor-specific header file,
either “MacHeaders68K" or “MacHeadersPPC”; depending upon which
processor you've selected in CodeWarrior's Target preferences panel. This
precompiled header file helps boost the compiler's processing speed when
it searches for routine definitions. It also means that if you stick with the

continues
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continued

most frequently used Manager routines, you needn’t worry about typing
#include Statements. However, not all of the header files are incorporated
into MacHeaders. If you're using some of the more sophisticated Toolbox
routines to, say, play sounds or do special printing, you'll need to include
those files at the start of your source code. Or, you can edit the supplied
“MacHeaders.c” file to add the missing header files, and recompile it with
the CodeWarrior compiler. This makes the header files you need part of
the precompiled header file. The “MacHeaders.c”, “MacHeaders.h”, and
assorted support files are located in the MacHeaders folder.

| prefer to enter all the header files anyway. This way you keep better
track of what Managers you're using, which helps with your program
design. It doesn't hurt having the header files declared in your program,
because even if you use the “MacHeaders” file, the Metrowerks
CodeWarrior compiler is smart enough to sort things out and prevent
redundant declaration errors from cropping up.

The definitions N1L, IN_FRONT, Is_visIBLE, and nNo_cLosE_gox are for use later in the
program. As you'll see, they’ll make a Window Manager routine that we use a
lot easier to understand. Now enter:

void main(void)

{

WindowPtr  thisWindow;
Rect windowRect;

/* Lunge after all the memory we can get */
MaxApplZone();
MoreMasters();
MoreMasters();

/* Initialize the various Managers */
InitGraf (&qd.thePort);
InitFonts();
FlushEvents(everyEvent, 0);
InitWindows();

InitCursor();



Now we’re getting somewhere. The variable windowptr holds a pointer to a
data structure that the Window Manager creates for us. The data helps
manage the window that will display the phrase “Hello world.” rect is a data
structure that describes a rectangle object to QuickDraw. If you use the
Metrowerks editor to examine the “Types.h” file, you’ll find Rect, which looks

like this:
struct Rect {
short top;

short left;

short bottom;

short right;
I

typedef struct Rect Rect;

Top and 1eft correspond to the x and y coordinates of a point that QuickDraw
uses in its drawing space. The bottom and right variables define a second
point’s coordinates. QuickDraw uses these two points to draw the rectangle.
How does it make a rectangle made up of four points (or eight xand y
coordinates) with just two points? QuickDraw relies on the fact that a rect-
angle can be drawn with this amount of data. First, QuickDraw draws a line
from point (top, 1eft) to point (top, right) to draw the top of the rectangle.
Next, QuickDraw draws a line from point (top, right) to point (bottom, right),
which draws the right side of the rectangle. Then QuickDraw follows with a
line from point (bottom, right) to point (bottom, left) to draw the bottom of the
rectangle. The line drawn from point (bottom, left) to point (top, left) closes
the rectangle.

MaxApplZone() is a Memory Manager routine that ensures the application has
sufficient memory. It does this by expanding the application’s heap (also
called a zone) as much as possible within the memory partition built for it by
the Process Manager. If you don't call this routine, the Mac OS assumes a
default heap size, which might not be adequate for your needs. This is
followed by calls to moremasters(), a routine that allocates what are called
master pointer blocks. These blocks contain pointers that help implement
the handles that are frequently used to access Toolbox data structures. If you
run out of master pointers, the Memory Manager will create more for you
automatically. However, since the master blocks can’t move about in
memory, you run the risk of fragmenting the application’s heap as memory



PowerPC Programmer’s Toolkit

becomes littered with these immovable memory blocks. The application will
also run more slowly as it struggles to organize the fragmented memory. If
you provide sufficient master blocks now, it eliminates potential memory
and performance problems in the future. Obviously, it’s better to call
MoreMasters () too much at initialization time, rather than too little.

Initializing Managers
Now we initialize the various Managers that we plan to use:

InitGraf (&qd.thePort);
InitFonts();
FlushEvents(everyEvent, 0);
InitWindows();

InitGraf () initializes QuickDraw. QuickDraw in turn sets up some global
variables it uses to manage the application’s graphic environment. The
storage for these variables is set up by the development system, which
QuickDraw accesses via the global pointer theport that you provide. Next, the
Font Manager is initialized so that text can be displayed within the window.
Flushevents() clears the event queues of any stray events when the application
is launched. 1nitwindows(), of course, readies the Window Manager.

Now it’s time to get into the actual mechanics of displaying the phrase “Hello
world.” Add to the program:

/* Set up the window */

windowRect.top = windowRect.left = 40;

windowRect.bottom = 200;

windowRect.right = 300;

if ((thisWindow = NewWindow(NIL, &windowRect,
“\pHello world", IS_VISIBLE, documentProc,
(WindowPtr) IN_FRONT, NO_CLOSE_BOX, NIL)) != NIL)
{
SetPort(thisWindow); /* Make window the current port */
MoveTo (20, 20);
DrawString("\pHello world");
InitCursor();

while (!Button()) /* Wait until mouse button clicked */

.
)



DisposeWindow(thisWindow); /* Clean up */
} /* end if */

else
SysBeep(30);

} /* end main() */

The first two lines of code plug coordinate data into the rectangle windowRect
that are used to make the window. If you're puzzled over the point data’s
positive values, that’s because in QuickDraw’s coordinate system, the upper
left corner of the screen is the origin, and larger positive numbers move a
point toward the right and downward. The values in windowrect have
QuickDraw create a window located forty pixels down and forty pixels to the
right of the screen’s origin. The window’s upper left corner starts at this
position, and the window is 200 pixels tall and 300 pixels wide.

The Newwindow() routine actually makes the window. The #defines we created at
the top of the program are put to use here. From them we can surmise that
the new window is visible on the screen, is supposed to appear in front of all
other windows, has no close box (the small square in the window’s upper left
corner that, when clicked on, removes the window), and its title will be Hello
World. Newwindow() s first argument allows you to place a pointer to a data
buffer for the window’s use. If this argument is NIL, as it is in our example,
the Window Manager allocates the window’s data storage on the heap, which
is fine for simple operations. However, if you display lots of text or large color
images in the window, you can severely fragment the heap. For these jobs,
it’s best to pass the address of a memory block to Newwindow(). Consult Inside
Macintosh: Macintosh Toolbox Essentials and Inside Macintosh: Memory for
more information on these issues.

Notice that we do some error checking here. If Newwindow() successfully creates
the window, it will return a pointer to the window’s data structure. If
Newwindow() has a problem making the window (possibly there’s not enough
memory), the routine returns a value of n1L. The it statement determines if
we received a valid pointer from the Window Manager. If not, the application
beeps and exits. Admittedly, a beep doesn’t offer much diagnostic aid to the
user, but it’s preferable to signal a problem this way and quit cleanly, rather
than have the Mac crash.

If we have a valid window pointer, the program next sets the window to be
the current drawing port by using setport (). QuickDraw always draws to the
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screen through a graphics port or grafport, which is another data structure
that describes to QuickDraw an area to draw on the screen, the size and
shape of this area, its coordinate system (which can be different from the
screen’s), what type of text to use, and other information. The Window
Manager creates a grafport for every window it makes, and your application
can create and manage many windows—and thus grafports—at once.
Through the setport () routine, we inform QuickDraw what grafport to draw
in, which in this case is our shiny new window. The following moveTo routine
nudges the current drawing point within the window down and right twenty
pixels. These values use the window’s own coordinate system, whose origin
is located at the window’s upper left corner. Finally, we use the prawstring()
routine to write the phrase “Hello world” in the window.

When the Process Manager starts the application, it changes the mouse
pointer, or cursor, to a stopwatch to indicate the Mac is busy. Now that our
initialization code has completed and the program displays the greeting, we
call nitcursor(), which changes the cursor back to an arrow. This indicates
that our application is ready to deal with the user.

If we simply let the program proceed, the window would appear briefly and
be gone. To let the window linger so that we can admire our handiwork, we
insert a while loop. This loop cycles until the routine Button() returns TRUE,
which occurs when you press the mouse button. Once the loop completes,
we clean up after ourselves by calling pisposewindow(), which removes the
window and purges the data structure made by Newwindow(). The final shape of
the program looks like so:

#include <Types.h>

#include <QuickDraw.h>

#include <Fonts.h>

#include <Windows.h>

#include <Memory.h>

#include <Events.h>

#include <OSUtils.h>

#define NIL oL
#define IN_FRONT (-1)
#define IS_VISIBLE TRUE



#define NO_CLOSE_BOX FALSE

void main(void)

{

WindowPtr  thisWindow;

Rect windowRect;

/*

Lunge after all the memory we can get */
MaxApplZone();
MoreMasters();

MoreMasters();

Initialize the various Managers */
InitGraf(&qd.thePort);
InitFonts();
FlushEvents(everyEvent, 0);

InitWindows();

Set up the window */

windowRect.top = windowRect.left = 40;

windowRect.bottom = 200;

windowRect.right = 300;

if ((thisWindow = NewWindow(NIL, &windowRect,
“\pHello world", IS_VISIBLE, documentProc,

Chapter_3_m_Using the Toolbox

(WindowPtr) IN_FRONT, NO_CLOSE_BOX, NIL)) != NIL)

{

SetPort(thisWindow); /* Make window current drawing port */

MoveTo (20, 20);
DrawString("\pHello world");

InitCursor();

while (!Button()) /* Wait until mouse button clicked */

3
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DisposeWindow(thisWindow) ;
} /* end if */
else

SysBeep(30);
} /* end main() */

Run the Code

Let’s compile and run this code. Using the seven-step procedure outlined in
Chapter 2, first save the code (if you typed it) into a file called He11o1.c. Next,
create a project called Hel10.p. Add “Hellol.c” to it, and remove the place-
holders from the project’s window. (You don’t need to do this with
CodeWarrior Lite on the Power PC Programmer’s Toolkit CD, because the
project file is already set up.)

Set the preferences in this project for the C/C++ Language, and PPC Project
panels. For the Language preferences panel, ensure that the Require Function
Prototypes item is checkboxed and that the Prefix File item is blank. In the
C/C++ Warnings panel, see that the usual items are checkboxed: Unused
Variable, Unused Arguments, and Extended Error Checking. For the PPC
Project preferences panel, name the output file He110. Now make the project
and run it. You'll get a window that resembles that shown in Figure 3.1.

[E——= Helloworld =——1

Hello world

Figure 3.1 The result of the “Hello world” program.

Click on the mouse button to quit the application. The font used in the
window was the default application font Geneva. One of Mac OS’s finer
features is that it has a smart set of defaults, which simplifies programming.



It took 50 lines of code to implement the “Hello world” program. Our result-
ing application doesn’t do much—but then neither does the Unix-style
version of the program that every beginning C programmer writes. It does
illustrate that the Mac OS is a complex environment that requires attention
to a lot of details before you can write code.

This very simple application required that we have a grasp of the Memory
Manager, the Window Manager, and QuickDraw. I've only provided superfi-
cial descriptions of some of the Toolbox routines used in the setup code. For
additional information, consult Inside Macintosh: Macintosh Toolbox Essen-
tials, Inside Macintosh: Memory, and Inside Macintosh: Imaging.

“Hellol.c” demonstrates the general initialization setup for a Mac applica-
tion. Later programs will require the setup of more Managers, but these will
just be additions to the code you've written here. Like the understanding of
the Mac itself, Mac programming is just a matter of continually adding
components to a basic structure.

The Fork in the File

Now that we’ve covered program initialization, let’s delve into a Mac file’s
structure. A Macintosh file is composed of two sections, a data fork and a
resource fork. Physically, there’s nothing different about these forks; each is
simply a stream of bytes located somewhere on the hard disk. However, the
Mac OS treats each file fork differently. The data fork typically contains data
created by an application, such as text from a word processor, numbers from
a spreadsheet, or PostScript commands from a drawing application.

The resource fork is a container for objects called—you guessed it—resources.
Resources contain data that is organized into predefined formats. This data
typically describes graphic elements such as icons, windows, and color tables.
Resources also contain nongraphic yet essential elements such as drivers or
program code. A resource type defines the resource to the Mac OS so that it
can properly interpret the data packaged within the resource. A resource type
is a four-character code, such as ‘CODE’, ‘MENU’, ‘WIND’, ‘cicn’, ‘cdev’, and
so on. As examples of how the resource type indicates what is inside a re-
source, consider that CODE resources contain processor code, MENU re-
sources contain the items that appear on a menu, and cicn resources hold
data that displays a color icon. In summary, the resource fork of a 680x0
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application contains such elements as program code, menu lists, windows,
and icons. The structure of a Power Mac application is somewhat different: It
still keeps the graphical elements in its resource fork, but the program code
is stored as a single block inside the file’s data fork. More on this later in
Chapter 4. For more details on a file’s data and resource forks, consult Inside
Macintosh: Files, and for more on resources, check Inside Macintosh:
Macintosh Toolbox Essentials.

@ Future Directions

Copland will use a completely re-engineered version of the File Manager
to handle larger volumes, and it will use more efficient I/O algorithms to
improve performance and reliability. One feature of this new File Manager
is that it supports any number of file forks, besides the usual data and
resource fork. The structure and contents of these additional forks are
determined by the programmer. For example, a game designer might store
the bitmaps for sprites in one custom fork, and the texture maps for
objects and hallways in another.

Besides the two forks, each file also has a type and creator. Like resource
types, file type information is a four-character code that describes a file’s
contents to the application that opens it. For example, a file type of ‘TEXT’
indicates that the file contains ASCII text, ‘TIFF’ indicates the file has Tagged
Image File Format bit-mapped data (typically a scanned image), and ‘APPL’
means the file contains program code organized as an application. The
creator information is a four-character code signature that’s unique to the
application that created the file. Each file’s type and creator information is
maintained in a desktop database file by the Mac OS. The Finder, the shell
application that displays and manages the so-called virtual desktop on your
Mac’s screen, uses the database file to display each file’s icon at the appro-
priate screen location. Where does the desktop database get a file’s type and
creator information, along with its file icon? From resources in your pro-
gram, of course.

To see how all this fits together, consider what happens when you double-
click on an document icon (say, a CodeWarrior project file). The Finder
detects this action, and obtains the file’s creator information from the



desktop database. Next, it searches for a file of type ‘APPL’ (an application)
with the same creator signature. If the Finder finds this application file (the
CodeWarrior IDE), it has the Process Manager launch it. If the Finder can’t
locate the application file, you get a warning on-screen that states: “The
document ‘Foobar’ could not be opened, because the application program
that created it could not be found.”

Obviously, the Metrowerks CodeWarrior IDE manages the CODE resources
in the application that we make. However, to build a complete Mac applica-
tion with menus, windows, its own custom icon, and signature information,
it's probably dawning on you that you're going to have to become familiar
with resources in greater detail. This assessment is correct, so let us begin.

Making Resources

As usual, the best way to learn about resources is to do something with them.
A great place to start would be to put a friendly interface on that user-hostile
file munger program we wrote in Chapter 2. First, consider what we want the
munger program’s interface to do. It should basically behave as before and
let you pick a file to open, ask you to name an output file, and then process
the chosen file. When munger finishes the job, you want a status report.
Once you've finished processing one or more files, you quit munger. With
some thought, we conclude that all the munger application really needs is
an Apple menu, a File menu, and an Edit menu. The Apple menu is just a
placeholder for an application’s About Box, the window where the program’s
description hangs out. The File menu needs an Open command to open the
desired files and a Quit command to exit the program. The Edit menu won’t
be of much use to our application; it’s there to assist passing events to other
applications under System 7’s cooperative multitasking environment. We
also need to design dialog boxes, which are the windows that display pro-
cessing statistics and warn of problems. Finally, we want to display a cool
About Box dialog box that describes munger when the About command is
chosen from the Apple menu.

Locate ResEdit, the resource editor, in the Apple Tools folder on the

CodeWarrior CD-ROM and copy it to your hard disk, if you haven’t done so
already. ResEdit lets you create resources, modify them, and save them to a
file’s resource fork, much like a text editor does with text data in a file's data
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fork. Launch ResEdit. Click on the splash screen to dismiss it. Click on the
New button. When the Standard File dialog box appears, type munger.m.rsrc.
(Remember, to get the © character, type Option-P.)

Hazard

Previous versions of the CodeWarrior IDE required that the resource
filename you chose closely matched the project’s filename. That's because
when you test drive an application in the CodeWarrior IDE, it does some
important housekeeping for you. By default, it searches for resources
(except for the CODE resources that it made) in a separate file whose
name begins with the project name and ends with the string “.rsrc.” For
example, for project munger.pt, we could keep our resources in a file called
“munger.prsrc.” This arrangement lets you rapidly modify graphical re-
sources in the resource file without having to attach them to the program’s
resource fork every time you want to test changes to the interface.

Starting with version 1.3 of the CodeWarrior IDE, the naming convention of
the resource file has been relaxed. That's because you can add a resource
file to the project, just like source code files and library files. Just go to the
Project Menu and select the Add Files... item. Then use the Standard File
dialog to locate and pick any resource files. Their names will appear in the
project window. Now when you build the program, the CodeWarrior linker
automatically appends any resources these files contain to the resulting
application file. If you wish, you can still use the naming convention and let
the CodeWarrior IDE manage locating and linking the resources for you.
For this example, we'll fly in the face of convention and give the resource
file a name different from the project file's to demonstrate how to add the
resource file to the project.

A window called munger.z.rsrc appears. This window serves as a view of the
file’s resource fork. It's empty because there are no resources in it—yet.
Thinking back to our interface design meeting a little while ago, we decided
that munger needed several menus. Go to the Resource menu and choose
the Create New Resource command, as shown in Figure 3.2.
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Figure 3.2 Preparing to make a new resource in ResEdit.

Making Menus

A dialog box appears, asking for a resource type. You can either scroll
through the list of defined resource types or type in one if you know it. Type
mEnu (as shown in Figure 3.3) and press Return.

Select New Type

Figure 3.3 Making a MENU resource.



Two new windows appear (see Figure 3.4). The frontmost belongs to the
menu resource editor, used to create and modify MENU resources. Say, this
looks promising. But what’s that MENU ID = 128 in the window title? To
distinguish among resources of the same type (MENU, in this case), each
resource has its own ID number. To uniquely identify and use a single
resource, you specify its type and this ID number. The resource ID number is
a 16-bit signed value. ID numbers from -32768 through 127 are reserved for
use by the Mac OS, while you're free to use ID numbers from 128 to 32767.
What ResEdit’s menu resource editor did when it created the resource was
conveniently pick the first available ID number.

& File Edit Resource Window MENU Style | Title

1216 aM (3 B

munger.mn.rsrc

F"__ MENUS from munger.m.rsrc
MENU ID = 128 from munger.7.rsrc

Entire Menu:

O & (Apple menu)

Enabled

R Color
Title: E'
Item Text Default: E'

Menu Background: D

Figure 3.4 The MENU resource editor.

Since the first menu is the Apple menu, click on the Apple menu radio button
in this window. The word Title changes to the Apple symboal, as shown in
Figure 3.5. Note also that the outlined menu formerly named Title in the
menu bar changed to the Apple symbol as well. This menu is a clone of the
menu you're constructing and it’s used for examining a menu’s arrangement
and appearance.

Now, press Return. You'll get a highlighted (darkened) area under the Apple
symbol. This is where you begin to add menu items. For the Apple menu,
type About Munger... (see Figure 3.6) and press Return. This is the program’s
About Box menu item.
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Figure 3.5 Making the Apple menu.
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Figure 3.6  Making the About Box menu item for the Apple menu.

For the Apple menu, the next menu item is simply a separator or divider line,
used to indicate where the application’s menu ends and the rest of the Apple
menu begins. To add a separator line, click on the separator line radio
button, as shown in Figure 3.7.

Now click the window’s close box and you'll see MENU resource 128 (see
Figure 3.8).

We still have two more menus to go. Once again select Create New Resource
from the Resource menu, or type Command-K. A new MENU ID = 129
window appears. Enter rile for the menu'’s title, press Return, and type
open. .. for the first menu item. Before you press Return, click on the box to the
right of the item labeled Cmd-Key in the Editor window, or press Tab to select
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it. Type o in this box (see Figure 3.9). The O character is the keyboard equiva-
lent for the Open menu selection. That is, typing Command-O initiates an
Open action, as if it were selected from the menu. Because keyboard equiva-
lents rely on the Command key, they are also called Command-Key equiva-
lents. This also explains the name of this Cmd-Key item in the editor window.

Eﬁﬁ MENU ID = 128 from munger. 7

T| Selected Item: [J Enabled

About Munger... 4>
— Text: O | I

C.l (separator line)

[] has Submenu

= Mark:] None
G i

Figure 3.7 Adding a separator line to the Apple menu.

[E=———= MENUs from munger.n ]
; it
About Munger...
L3
SE— &
Figure 3.8 MENU ID 128, as it will appear in the application.
EE=——— MENUID - 129 from munger.n =————
File Selected Item: X Enabled

Open... 80 J<+

Teut: ® IOpen... |

)i (separator line)

[] has Submenu

= Mark:| None V|E]

Figure 3.9 Entering the keyboard equivalent for the Open menu item.



Press Return and then add a separator line by clicking on the separator radio
button. Press Return again and type auit. Then, type a a in the Cmd-Key item
box. That completes the File menu. You can then pull down the test menu to
examine it (see Figure 3.10). Click on the window’s close box and save the file.

Now to add the last menu, the Edit menu. Type Command-K to create a new
menu resource. The window MENU ID = 130 appears. Type edit for the menu
title, press Return, type undo, press Tab, type z, and press Return, which
makes the Undo item in the menu. It has the keyboard equivalent of
Command-Z. Add a separator line and press Return, type cut, press Tab, type
x, then press Return to add the Cut item to the Edit menu. Add the Copy item
by typing copy, Tab, ¢, and pressing Return, then type in paste, Tab, and v to
create the Paste item. Click the window’s close box, and you should see all
three menus, ready to go, as shown in Figure 3.11. Save the file, and close the
window by clicking on the close box, or typing Command-W.

® File Edit Resource Window MENU Style e (2
MUNGer.n.rsrc Jpe sl
B == Quit 0
MENUs from munger.w.rsrc
MENU 1D = 129 from munger.7.rsrc
4| - Selected Item: [X] Enabled
80 [ir
Text: @ |Quit |
0 0
() -~ (separator line)
g :
Color
[ has Submenu Texnt: El
ol
m cma-key: [0 | I
MUNG i M"”“-E

Trash

Figure 3.10 Testing the completed File menu in ResEdit.
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1" About Munger...

Quit 30
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Figure 3.11 The complete MENU IDs for the munger application.

Making Dialog Boxes

Now, let’s make the dialog boxes for munger. Choose Create New Resource
again, and this time type pLoe and press Return. A dialog editor window
opens, with the title DLOG ID = 128 (see Figure 3.12).

€ File Edit Resource Window DLOG MiniScreen 11:43 AM CD

munger.vw.rsrc

I DLOGs from munger.7.rs

DLOG ID = 128 from munger.7.rsrc

CLE

Color: (@ Default
(O Custom

DITL 1D:
Toxt Height: [ Initially visible

X Close box

Left: Width:

Figure 3.12 The dialog editor window.



About Boxes are typically dialog windows, because this type of window
requires little program code to support it. By default, the editor has selected
a standard document window, complete with a drag region, a close box,

and a grow icon (the small box at the window’s bottom right corner). In
short, a window with all the bells and whistles. Go over to the sixth window
icon from the left and click on it, as shown in Figure 3.13. Notice that the
window’s appearance has changed. This is the alternate dialog window,
which is just a variation of the dialog window. This window type has no drag
bar, no close box, and no grow icon. It’s pretty simple as windows go, which
is what we want.

OLOG 1D = 128 from munger..rsrc ==——————

][] EE

€ Filu_ Edil Basourca Window Color: @ Default
(O Custom

DITL 1D:
Initi isi
Top: Height: [200 X Initially visible

Left: (40 | width: [240 | [ Close box

Figure 3.13 Picking the alternate dialog window.

Click on this window’s upper left corner and drag it near the top of the
screen. Next, click on the dark square at the bottom right of the window, and
drag it. The window’s size will change depending upon how you drag this
square. Size the window according to what suits you, and release the mouse
button (see Figure 3.14).
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Figure 3.14 Resizing the dialog window.

Editing Dialog Boxes

Now, double-click on this window. A pair of windows appears (see Figure
3.15). This is the dialog item, or DITL, resource editor. While the menu editor
lets you add and delete items from a MENU resource, the situation is more
complicated with dialog windows. The dialog editor manages DLOG re-
sources, which determine a dialog window's type and size. However, objects
that appear in the window, such as buttons, icons, and text, belong to
another resource, of type ‘DITL’. DITL resources contain lists of dialog items,
just as MENU resources contain lists of menu items. Naturally, changing
DITL resources requires a separate editor, which is why that dialog item
editor just appeared.

Although the DLOG and DITL editors operate so seamlessly that they appear
to function as a single editor, it’s very important that you remember that
you're working with two different resources here. Notice that the DITL

ID number is 128. It’s not required that a dialog’s items (DITL resources)
have the same ID number as the dialog window (DLOG) that they appear in,
but it does keep tracking the relationships between the two resources simple.
If you need to use a different DITL ID number, you can change the linkage by
typing a different ID number in the DITL ID item on the DLOG Editor
window in the background.
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Figure 3.15 The DITL editor, for modifying dialog items.

Go to the floating window with the dialog items on it (the window at the

right), and drag the static text object to the

dialog window, as shown in

Figure 3.16. Static text can’t be changed by the user during the life of the
dialog window, so it’s useful for handling the titles of buttons and controls.

DLOG 1D = 128 1

Button

nger.m.rsrc

I%‘

ﬁé DITL ID = 128

X Check Box

{® Radio Button

Color: @ Default

Control

Top: (32 | Height: [95 |

Leﬂ:|14 | widtn:||52 ]

(O Custom

User Item

DITL ID:

[ Initially visible

[X Close box

Figure 3.16 Adding a static text item to the About Box.

Release the mouse button when you've positioned the text object where you
want it. In this example, let’s drop it near the top of the window. Now
double-click on this object, and a window titled Edit DITL item #1 appears.
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Replace the highlighted text by typing munger 1.0, pressing Return, typing
written in, pressing Return, and typing metrowerks ¢ (see Figure 3.17). This is
our About Box information.

Eﬁ%“““__ Edit DITL item #1 from munger.7.rsrc

Text: | Munger 1.0
Written in

Static Teut  += Metrowerks C
Ly

[l Enabled Top: Bottom:
Left: Right: @

Figure 3.17 Changing the text of DITL item #1.

Click on this window’s close box, and resize the static text box by clicking
and dragging with the mouse (see Figure 3.18). You’ll have to tinker with the
box and text somewhat until you get it to look neat. Use ResEdit’s Alignment
menu to center this text box in the window.

[E= DITL ID = 128

Figure 3.18 Modifying the size of the dialog item.

Adding Buttons

Now, go back to the dialog items window, and drag a button item to the
dialog window, and position it under the text, as shown in Figure 3.19.

Release the mouse button and a button item appears. Double-click on it to
open an Editor window so that you can change the button’s text. Type ok (see
Figure 3.20). Close the window and use the Alignment menu to center the
button.
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Figure 3.19 Adding a button to the dialog window.
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Figure 3.20 Changing the button’s title.

Numbering Dialog Items

There’s one more crucial step we have to do here: renumber the dialog items.
The reason is that certain dialog Toolbox routines that manage the dialog
items look for Return keystrokes. They pass this action onto the first item in
the dialog list, just as if you had clicked on that item. What we want to
happen is that when the user presses Return, it activates the OK button,
which then dismisses the About Box window.

Go to ResEdit’s DITL menu, and select Renumber Items.... A new window
appears, with instructions on how to renumber the items. Hold down the
Shift key, then click first on the OK button, and then the About Box informa-
tion (see Figure 3.21). Click on the renumber button, and you're done. You
could have avoided renumbering these items by putting the OK button in the
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window first, then adding the About Box static text. Occasionally you have to
renumber items after the fact, so it’s worth pointing out this feature in
ResEdit now.

EE DITL 1D = 128 ==

:rﬁ.l:llﬁg'é?. .I.Hié E Check Box

: Writtenin ¢
‘:M.t.a.lmmt.a.r!s.s,léi ® _Radio Button
T b B l:ont.rol

T

i
Use shift~click to select the items in the
order you want them to be renumbered.

( cancel ] (Renumber)

Figure 3.21 Changing the dialog item numbers.

Close the DITL editor by clicking on the close box, which lands you back in
the DLOG editor. If you want to preview how the About Box looks, pick
Preview at Full Size from the DLOG menu. Close the DLOG window and save
the file.

Status Display

We also decided that we wanted a status display when munger finishes
processing a file. Let’s start by typing Command-K to create a new DITL
resource. As the title to the DITL Editor window indicates, this resource has
an ID of 129. Click on the eighth window from the left to select the dialog
window type. The window changes from a document window type to a
dialog window, as shown in Figure 3.22.

Double-click on the window to bring up the DITL resource editor. Go to the
floating dialog item window and drag a static text item to the new window.
Adjust the item’s width by dragging with the mouse until the item spans
most of the window. Now copy and paste this item. Nothing appears to have
happened, but if you click and drag on the static text item, you'll uncover an
identical static text item beneath it. Copy and paste again to clone the item
one more time, then arrange the three items above one another in the dialog
window. This gives you three static text items of the same size. Use the
Alignment menu to center the items in this window, as shown in Figure 3.23.
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Figure 3.22 Changing the window type to a dialog window.
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Figure 3.23 Centering the three cloned dialog items.

Click the top static text item to select it and edit its contents by double-
clicking on it. Type File: ~0. The caret and number operate as a special
placeholder where the dialog Toolbox call will substitute a text string, in this
case a filename. We’ll see how this works a little later. Go to the second item,
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open the item, and type Bytes read: ~1. Open the last item and type Bytes
written: ~2. Resize the window and align the items again. The dialog window
should appear similar to the one in Figure 3.24. This completes the status
window.

= DITL 1D = 129 from munc =

File: “0

Bytes read: ~i

Bytes written: *2 S

Figure 3.24 The completed status dialog box.

Adding Alerts

Now for one last window. In an ideal world, our code is bug-free and a user
will never try to add one more munged file to a jam-packed hard disk. Because
such a world doesn't exist, we need to report errors when they occur, whether
it’s a problem with the code or a user mistake. For this window, we’ll use an
alert resource of type ‘ALRT’.

What is an alert? An alert is a special dialog window that beeps the Mac and
requires that you click on a button to dismiss the alert. This way, the alert
grabs the user’s attention and ensures that he responds to the error message.
There are several types of alerts—note, caution, and stop—and each has a
distinctive icon to indicate the severity of the problem. Note alerts provide
information, usually to offer the user a choice. Caution alerts warn the user
of a situation that could result in data loss if not dealt with carefully. For
example, caution alerts warn of insufficient disk space to save a certain file,
or that memory is running low and the user should save his work, or that
proceeding with an operation will delete a file. Stop alerts flag a problem so
serious that the application can’t complete the operation. An example of a
stop alert is when the program detects an error while writing a file to disk.

For the munger program, we can anticipate that disk I/O is where most
problems will occur. Since most disk I/0 problems—such as running out of
disk space—are difficult to recover from without lots of intervention on the
user’s part, munger will just quit the operation and post a stop alert.
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Let’s make a stop alert for munger. Get out of ResEdit’s DLOG editor by
closing the Editor window. Type Command-K to make a new resource, and
type ALrT in the Select New Type dialog. The alert resource Editor window
appears, with a default of ALRT resource ID 128. Notice that the alert window
already has dialog items in it (see Figure 3.25). Remember that the objects
displayed in the dialog box actually belonged to a different resource? What'’s
happening is that the alert editor is, by default, using DITL resource ID 128,
whose items already belong to the About Box dialog.

& File Edit Resource Window ALRT MiniScreen 10:31 AM
munger.n.rsrc
HLF-{T;-n‘um Mmunger.7w.rsre
D El=—————— ALRT ID = 128 from munger.7.rsrc
1 & Flio Edil Besourta Window Color: @ Default
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Figure 3.25 The alert resource editor.

You have two options here. You can change the ID number that links the
DITL resource to the ALRT resource, or change the ALRT resource ID. I keep
the organization of these linked resource ID numbers simple by using an
ascending list of ID numbers that’s divvied up among the DLOG and ALRT
resources. That is, an ALRT resource might get an ID of 128, a dialog a
resource ID of 129, another ALRT gets ID 130, and so on. So, let’s change the
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ALRT resource ID. Start by selecting Get Resource Info from the Resource
menu, or typing Command-I. An Info box appears (see Figure 3.26). Type 130
to change the ALRT ID, and then close the window.

[EEI==Tnfo for ALRT 130 from munger.w.rsrc %

Type: ALRT Size: 12
1D: 130
Name: X 4'
Owner type
Owner 1D:
Sub 1D:
Attributes:
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[J Purgeable [OProtected []Compressed

Figure 3.26 Changing the ID of the alert resource.

You'll notice that the dialog items haven’t changed yet. Go to the DITL ID
item in the alert Editor window and type 13e. Now you have a blank window,
as appears in Figure 3.27.

Double-click on the window to summon the DITL editor. Drag a static text
item to the window, and edit it to say 1/0 error, Ip = ~o, as shown in
Figure 3.28.

Now drag a button item to the window and edit it to say ok. Align the two
items and resize the window to fit. Be sure to leave room at the window’s top
left corner so that the Dialog Manager can drop a 32-by 32-pixel stop alert
icon into the window when it’s drawn. Renumber the dialog items so that the
OK button is item number 1. Again, we do this because the Dialog Manager
passes Return key events to the window’s first dialog item, and we want that
to be the OK button. Also, for alerts, the Dialog Manager draws a bold outline
around DITL item 1, on the assumption that it’s the default button (an OK
button in this instance). The alert window should appear as shown in

Figure 3.29.
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Figure 3.27 Changing the ID of the alert’'s DITL resource.
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Figure 3.28 Adding the alert's static text message.
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Figure 3.29 The completed alert dialog.
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Important

As discussed earlier, the default button—the item that the program as-
sumes the user will pick most of the time—is always DITL item 1. For alert
boxes with more than one button, DITL item 2 should always be the
Cancel button.

There are two last details to take care of. First, we want the alert window to
appear centered on the screen. This turns out to be a simple job. Close the
DITL Editor window to get back into the alert editor and pick the Auto
Position... from the ALRT menu. A dialog window appears that allows you to
set the window’s characteristics so that System 7 will automatically center
the window for you (see Figure 3.30). Go to the active pop-up menu (the one
on the left), and select the alert position. (Alert windows are required to
appear on certain areas of the screen.) The right pop-up menu becomes
active, but since the Main Screen default setting is fine for now, just click on
the OK button to make the changes. Save the file. If you want, you can also
enable the auto-centering settings of the other dialog boxes. Before you do,
consult Inside Macintosh: Macintosh Toolbox Essentials for important
guidelines on these settings.

Automatically Position the Window
(Works only with System 7.0 or later.)

vNone On | Main Screen \d |
Center

e -

Figure 3.30 Setting the alert window's screen position.

Background Info

In pre-System 7 days, dialog boxes would appear on-screen where they
were drawn in the resource editor. Because monitors of any size and
shape could be attached to the Mac, the default location of these windows
weren't always in the best position for visibility, especially on a large




monitor. You could always write code to determine the Mac's screen size
and then position the dialog window appropriately before showing it. This
code could get extremely complicated if the system had multiple monitors
in use. While such code isn't impossible to write, it was an imposition on
the programmer’s resources, which were better spent writing the applica-
tion, not managing the interface. As you saw with the alert editor, System
7 now handles this job. This is one of the many improvements in System 7
that both relieves the programmer of an interface detail, and makes
applications more visually consistent to the user.

The other detail is that the dialog item lists aren’t cleared from memory
automatically when the alert or dialog box is closed. To help the Memory
Manager reclaim the memory used by these item lists, we mark the DITL
resources as purgeable. To do this, first close the alert resource editor win-
dow and then the ALRT resource window. The resource fork of
“munger.z.rsrc” should contain four resources, as shown in Figure 3.31.

ALRT DITL DLOG
(==
MENU
&
5]

Figure 3.31 The resources the munger application uses.

Next, double-click on the DITL icon to get a view of the DITL resources, from
128 to 130. Hold down the Shift key and click on each DITL resource to select
it. Choose Get Resource Info from the Resource menu and three Info win-
dows should appear, as shown in Figure 3.32. Click on the Purgeable
checkbox for each DITL resource to select Purgeable. Close the windows.
Save the file and quit ResEdit.



€ File Edit Resource Window 436 PM (2

munger.mw.rsic

DITLs from munger.m.rsrc
D Info for DITL 128 from munger.7.rsrc
1 T Info for DITL 129 from munger.w.rsrc
I b Eis Info for DITL 130 from munger.7.rsrc
1o | TYPEF—— -
N Nam ID: Type: DITL Size: 50
Nam 10:
Name: |
Owner type
Owner 1D: nlllnnuEI: %
Attr
Sub 1D:
sy Attr MR
OPY Os{ attributes:
0Py Jsystem Heap [JLocked [ Preload

IXkPurgeahle [JProtected [JCompressed

Trash

Figure 3.32 Setting the DITL resources as purgeable.

Saving Resource Data as Text

This excursion with ResEdit covered a lot on resources. You might be won-
dering if there is a way to save the information they represent in a text
format. This would allow a resource’s contents to be distributed on paper, or
as 7-bit ASCII over the Internet. For huge programs with dozens of menus,
windows, dialogs, and alerts, it’s easier to search for an item to modify using
a text editor rather than poking around in a resource fork with ResEdit. And
yes, you can save the information in a text format. Along with ResEdit,
CodeWarrior supplies two Macintosh Programmer’s Workshop (MPW) tools,
called DeRez and Rez. The DeRez tool takes an existing .rsrc file and trans-
lates its resources into text descriptions. The text description uses a C-style
programming language that accurately describes a resource’s data. The Rez
tool takes these text files and converts them back into binary resources. A
new version of Rez now “plugs” into the CodeWarrior IDE so that you don’t
have to deal with the MPW environment at all. You can access the MPW



version of these tools from the Metrowerks CodeWarrior IDE by selecting
Start Toolserver from the Tools menu. The plug-in version of Rez simply
requires that you add the text description file to your project. For more
information on how to use Rez and the Toolserver, see Chapter 5.

Some Words on Events

Now that we’ve got the new and improved munger interface constructed,
we're almost ready to start writing code. First, a brief description of how a
Mac application operates is in order. As you work with the Mac, you generate
events. There are two types of events: low-level and high-level. Low-level
events are actions such as keystrokes, mouse clicks, and the insertion of the
occasional floppy disk. The Mac OS uses the Event Manager to detect these
actions and place them in an event queue for the application. High-level
events are used to establish communications among applications. Such
communications might request data from another application, or command
an application to print a file. We’ll deal with high-level events later in this
chapter.

Your application takes these events from the queue and responds to each type
as required. It does this using what'’s called an event loop. In the event loop,
the application circles endlessly, obtaining events from the OS by calling the
routine waitNextevent (). If an event is forthcoming from waitNextevent(), the
event loop next calls the appropriate function to handle the event. For
example, if your application receives a keystroke (actually a key down event
to the Mac), the action is passed to a function that might drop the character
into a document window. Note that if certain windows are active (such as a
Desk Accessory) or certain key combinations are pressed, different sets of
handler code might be called to process the event. Continuing with our key
down example, if you hold down the Command key while typing a character,
the application instead calls functions that ultimately have a Menu Manager
routine field the event. (Recall that a Command-key combination can be the
keyboard equivalent for a menu choice.) A Mac application, in some in-
stances, can be programmed to ignore certain events.

The basic structure of a Mac application is shown in Figure 3.33. A Mac
application goes through its initialization phase and then runs in an event
loop. As events trickle in, the event loop code checks to see what type of
event occurred, and calls the corresponding function to handle the event. It
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keeps doing this until the user signals the application to quit. At this point
the application exits the event loop and performs any required clean up
operations, such as saving files or discarding memory buffers.

INITIALIZE
MANAGERS

EVENT
RETRIEVED?

CALL EVENT]
HANDLER

EVENT WAS
USER WANTING
JO QuUIT?

YES

END

Figure 3.33 Structure of a Mac application.

An important distinction to make here is that events might occur in any
order, and your program must be structured to deal with such disordered
input. It shouldn’t force the user through a gauntlet of dialog boxes that
prompt for information. Also, because users aren’t likely to explore every
menu choice or dialog box setting, applications should provide reasonable
defaults that help them get started. As an example of this, a word processor
should default to a specific font (such as Times) and point size (say 12, for
example) when displaying text. Along these same lines, any setting that the
user might change frequently (such as the baud rate in a terminal emulator
application) should be easy to find and change. If you're not familiar with
this sort of user interface design, be sure to check out Apple’s Human Inter-
face Guidelines.



Code at Last

With the interface in place and a firm understanding of events, we can
rewrite the munger program. Fire up CodeWarrior’s IDE and create a new
project. For a project name, type munger.p. (Remember that the project name
either must correspond to the resource filename “munger.n.rsrc” that we
made with ResEdit, or in this case, we must manually add the resource file to
the project.) Now pick Add File... from CodeWarrior’s Project menu, and
along the path CodeWarrior:Example Code PPC:MacMunger, open the file
“Macmunger.c.” Inside the Project window, double-click on the
“Macmunger.c” file to open it with the built-in editor. In the Editor window,
examine the following code:

#include <Types.h>
#include <QuickDraw.h>
#include <Windows.h>
#include <Fonts.h>
#include <Controls.h>
#include <Dialogs.h>
#include <Menus.h>
#include <Devices.h>
#include <Memory.h>
#include <Events.h>
#include <Desk.h>
#include <OSEvents.h>
#include <OSUtils.h>
#include <ToolUtils.h>
#include <TextUtils.h>
#include <StandardFile.h>
#include <Errors.h>
#include <Resources.h>
#include <DiskInit.h>

/* Resource ID numbers */

#define LAST_MENU 3 /* Number of menus */
#define APPLE_MENU 128 /* Menu ID for Apple menu */
#define FILE_MENU 129 /* Menu ID for File menu */
#define EDIT_MENU 130 /* Menu ID for Edit menu */

#define RESOURCE_ID 127 /* Starting index into the
menu array */



#define ABOUT_BOX 1 /* About box menu item # in
Apple menu */

#define OPEN_FILE 1 /* Open item # in File menu */
AR */ |/* Separator line is item # 2 */
#define I_QUIT 3 /* Quit item # in File menu */

#define ABOUT_BOX_ID 128 /* Resource IDs for our windows
& dialogs */

#define STATUS_BOX_ID 129

#define ERROR_BOX_ID 130

/* Various constants */

#define NIL oL
#define FALSE false
#define TRUE true
#define INIT_X 112 /* Coords for disk init dialog box */
#define INIT_Y 80
#define APPEND_MENU ]
#define CHAR_CODE_MASK 255
#define IN_FRONT -1
#define NO_CURSOR oL
#define ONE_FILE_TYPE 1
#define LONG_NAP 60L
#define CR 0x0D
#define LF 0x0A

As you can see, we intend to use more Managers this time, and consequently
have more header files to include.

Next, we define the resource ID numbers of our menus and dialog boxes.
These values come straight from our work in ResEdit. Look carefully at the
menu item numbers in this section. These are values that the Menu Manager
returns to the program when the user makes a menu choice. Notice that the
menu item numbers start at 1, and that each separator line also counts as a
menu item. If you add or remove items from a menu resource, the item
numbers returned by the Menu Manager will change. You'll have to edit the



definitions here to match the new menu resource. To help keep this arrange-
ment straight, notice how the #defines for the File menu are written so that
they resemble the File menu layout. The rest of the section defines constants
that we’ll use elsewhere in the program, including Return and Line Feed.

Here are some function prototypes:

/* Function prototypes */

Boolean Do_Command (long mResult);
Boolean Init_Mac(void);

void Main_Event_Loop(void);

void Report_Error(OSErr errorCode);

/* Application-specific functions */
void Ask_File(void);
void Munge_File(short input, short output, unsigned char *fileName);

/* Globals */
MenuHandle gmyMenus[LAST_MENU+1]; /* Handle to our menus */

EventRecord gmyEvent; /* Holds event returned by 0S */
WindowPtr  geventWindow;